
TRADE:  COMPUTER APPLICATIONS 

 
 
 
Level:   I 
 
 
 
 
Module: 01  COMPUTER AWARENESS, OPERATION AND  

TROUBLESHOOTING 
 
 
Unit:   1.1  COMPUTER BASICS, HARDWARE AND SOFTWARE 

 

Training and Leaning Element [TLE]: 1.1.1 LOGGING ON TO WINDOWS  
                                                                                  AND  

SHUTTING DOWN YOUR 
COMPUTER 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Preparation of Training 
 
 
 
Learning objective 

 
At the end of this element, trainees should be able to log on to 
windows and shut down the computer. 
 

 
Duration 

 
30 min 
 

 
Range Statement 

 
Computer and windows 95/98/2000 software 
 

 
Training Materials 

 
NIL 
 

 
Instructional AIDS 

 
Information sheet 
 

 
Reference Materials 

 
Introduction to Microsoft Windows 95- for distribution only with 
new PC 
 

 
Trainees preparation 

 
Be aware of the computer room regulations 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 



 
Presentation of training / teaching steps 
 
 
Demonstrate and explain the process of logging on to Windows and shutting down the computer 
When you start Windows, you may be prompted to log on to Windows or, if you are on a network, to log on to 
your network. 
If you don’t want to log on with a password, don’t type anything in the password box, and click OK. You 
won’t see this prompt in the future. 
To log on to windows 

 1.  In the User Name box, type your name. 
 2. In the Password box, type a password. The first time, windows prompts you to confirm your password 

The start button and taskbar 
The start button and taskbar are located at the bottom of your screen when you start Windows for the first time. 
By default, they are always visible when windows is running. 
Shutting Down Your Computer 
You need to shut down Windows before you turn off or restart your computer. That way you can be sure your 
work is saved to your hard disk. 
Caution to Avoid damaging files, always shut down Windows before you turn off your computer. 
To quit windows and Shutting Down Your Computer 
1. Click the Start button, and then click shut Down 
2. Click Yes. If you forget to save changes to documents, Windows prompts you to save changes. 
3. A screen message lets you know when you can safely turn off your computer. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Practical performance Assessment 
Direct Performance: 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Be able to log on to Windows 
and shutdown the computer 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
(1) Log on windows 
 
(2) Shut down the computer 
 
 
 
 
 
 
 
 
 
 

 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 



Product Assessment 
 

Product Specifications Assessment 
 Acceptable Needs for the Adjustments Not Acceptable 
(1) Computer logged on 

to windows 
 
(2) Computer shutdown 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
 
 



KNOWLEDGE ASSESSMENT 
ORAL WRITTEN 
Explain why using the shutdown process 
instead of put off the switch button 

(1) Describe the process of shutting down 
your computer 

 
(2) Describe the process of logging on to 

the windows. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 



3.  Information sheet (Handout) 
 
 
- Check for configuration 

- Connect the processor with its peripheral devices. 
 
- Start and check for error message from the processor 
 
 
- Open the program sequentially to check performance 
 
- Clean outer part and cover the computer system 
 

 

 

 
 
 
 



 
 
Practical performance Assessment 
Direct Performance 
 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Be able to identify the internal 
parts of the computer system 
unit 
 
 
 
 
 
 
 
 

(a) Identifying processor 
 
 
(b) Identifying Hard disk  
 
 
(c) Identifying floppy disk 

drive 
 
(d) Identifying Data bus 
 
 
(e) Identifying Mother board 
 
 
(f) Identifying memory 
 
 
(g) Cover is properly opened 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 



 
 
 
 
Product Assessment 
 
Product/Service Specifications Assessment 
 Acceptable Needs  Adjustments Not Acceptable 
(1) System Unit cover not 

damaged 
 
(2) Processor identified and not  
damage 
 
(1) Hard disk identified and 

not damaged 
 
(2) Data bus identified 
 
(3) Mother board identified 

and not damaged 
 
(4) Memory identified and not 

damaged 
 
(5) The computer closed 

properly and working as 
usual. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 



 
 

KNOWLEDGE ASSESSMENT 
 
 
ORAL WRITTEN 
A trainee should answer this questions 
orally 
 
(a) What precautions should be considered 

when dealing with internal parts of the 
computer? 

 
(b) The extension slots are used for what? 

(1) The following questions should be 
answer in a  

 
(a) What is the use of data bus? 
 
(b) What is the use of floppy disk drive? 
 
(c) What is the different between Memory 

and Hard disk? 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 



TRADE:  COMPUTER APPLICATIONS 

 
 
Level:   I 
 
 
 
 
 
 
 
Module: 01  COMPUTER AWARENESS, OPERATION AND     
                                TROUBLESHOOTING 
 
 
 
Unit:   1.1  COMPUTER BASICS, HARDWARE AND SOFTWARE 

 

[TLE]:         1.1.3  CONNECTING A COMPUTER SYSTEM UNIT AND  
ITS PERIPHERAL DEVICES  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and  Training Authority 
 
 



1. Preparation of Training 
 
 
Learning objective 

 
At the end of this element the trainees must be able to connect 
the system unit and its peripheral devices recording to a giver 
standard and specifications 
 

 
Duration 

 
6 hours 
 

 
Range Statement 

 
Computer system unit, keyboard, mouse, printer, monitor, hand 
tools (screw driver etc), and extension cable, computer table 
 

 
Training Materials 

 
NIL 
 

 
Instructional AIDS 

 
Handouts, whiteboard, tutorial-CD if available 
 

 
Reference Materials 

 
At certification book – by Charles J.  
System upgrading 4th Edition.  
How computer works – By Isaack 
 

 
Trainees preparation 

 
Be aware of the computer room regulations 
 
 

 
 
 
 
 
 
 
 
 
 



 
3. Preparation of exercises/lessons 
 

Demonstrate and explain to trainees how computer system works with peripheral devices. 
Steps: 
1.0      Connect Computer peripheral devices to the  
           system unit 
 
1.1 Connect monitor to system unit  
 
1.2      Connect keyboard to system unit  
 
1.3     Connect Mouse to a system unit  
 
1.4      Connect  printer to the system unit  
 
Check to verify connection  
2.1 Check the monitor connection 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 



1. Preparation of exercises/lessons 
 
 
1.2 Check and verify mouse and keyboard  

Connection 
 
1.3 Check and verify printer connection 
 
3. 0   Power on the system to  
         run software configuration  
3.1 Power on the UPS (Un-interruptible Power  Supply 
3.2 Power on the monitor 
3.3 Power on the system unit 
3.4 Wait until operating system software complete execution 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



2. Preparation of exercises/lessons 
 
 
4. Demonstrate how to identify errors displayed on  
    the monitor or beeps codes  
 
 
4.1 Read messages displayed by the monitor during system load windows 95/98 
 
4.2 Identify the monitor keyboard error 
 
4.3 Disconnect keyboard and then start again the system to recognize error message 
 
4.4 Disconnect mouse and start again the system 
 
4.5 Repeat the exercise for all peripheral devices to recognize error message 
 
 
 
 
 
 
 
Refer at certification by Charles J. Brooks 
 
 
 



 
 
3. Information sheet (hand out) 
 
 
To start connecting your computer peripheral devices to the system unit follow the following: 
 
STEPS: 
1.0   Connect computer peripheral devices to the  
        system unit 
1.1   Connect monitor to the system unit 
1.2  Connect keyboard to the system unit 
1.3   Connect mouse to the system unit 
1.4 Connect printer to the system unit 
1.5 Check to verify connection  
2.1 Check the monitor connection 
 
 

 
 
 



 
 
Information sheet (hand out) 

2.2 Check and verify mouse and keyboard   
Connection 

2.3  Check and verify printer connection 
3.         Power on the system to run software  
           configurations 
Steps: 
3.1     Power on the UPS (Un-interruptible Power     
         Supply) 
3.2    Power on the monitor 
3.3   Power on the system unit 
3.4   Wait until operating system software complete   
       execution 
 

 
 
 
 



Information sheet (hand out) 
 

Stops to check for error messages  
 
 
4.1  Read messages displayed by the monitor  
      during system load windows 95/98/2000 
 
 
4.2  Identify the monitor  or keyboard error 
 
 
4.3   Disconnect keyboard and then start again 
        the system to recognize error message 
 
 
4.4  Disconnect mouse and start again the system 
 
 
4.5  Repeat the exercise for all peripheral devices to recognize error message 
 
 
 
 
 
 
 
 
 
Refer at certification by Charles J. Brooks 
 
 
 



 
Practical performance Assessment 
Direct Performance 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Be able to connect the 
computer peripheral devices 
to the system unit (monitor, 
mouse, printer and keyboard) 
according to a given standard 
and specifications 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Monitor connected 
accordingly 

 
(2) Mouse connected at the 

right port 
 
(3) Printer connected at the 

right port 
 
(4) Keyboard connected at the 

right port 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 
 



Product Assessment 
Product/Service Specifications Assessment 
 Acceptable Needs  Adjustments Not Acceptable 
(1) Computer connected as 

required 
 
(1) Peripherals connected to the 

right ports 
 
(2) Computer switched and 

working without displaying 
peripheral devices errors 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
 
 



KNOWLEDGE ASSESSMENT 
ORAL WRITTEN 
Answer the following questions orally 
verbally  
 
(a) What will happen if you change the 

ports of the computer peripheral 
devices? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 



 
 
Trade: 1  COMPUTER APPLICATIONS 

Module: 1  MICROSOFT WINDOWS 95/98/2000 
 
Unit:   1.2  PREPARING DISKS AND ORGANIZING FILES AND 

FOLDERS 
 

[TLE]:         1.2.1  CREATING NEW FOLDERS 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 
 



 
  Preparation of Training 
 
 
Objective 

 
At the end of this element the trainees must be able to create 
folder 
 

 
Duration 

 
2 hours 
 

 
Equipment/tools 

 
Computer  
 

 
Training Materials 

 
NIL 
 

 
Teaching aids 

 
Handouts  
 

 
Reference Materials 

 
Microsoft word 97 Users guide 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
2. Preparation of Training     
Duration Instructional Steps Illustrations/Instructional points aids 
 Explain the importance of 

creating folders. 
 
Steps: 
(1) Click on the start button 
 
(2) Slide the mouse pointer to 

programs 
 
(3) Click on the windows 

explorer to display the disk 
structure 

 
(4) Select the location, then 

click on file menu. 
 
(5) On the file menu select 

New, then New folder will 
appear on the selected 
location click the new folder 

 
(6) Type the name of the folder 

so that it will represent the 
useful name for your folder 

 
 
 
 
 
 
 
 
 

 
 

 
 
 



Information sheet (Handout) 
 
Duration Implementation  Steps Illustrations 
 To create new folders follow the 

following steps 
 
 
(1) Click on the start button (fig 1) 
 
 
(2) Slide the mouse pointer to 

programs (fig 1) 
 
 
(3) Click on the windows explorer to 

display the disk structure (fig 2) 
 
 
(4) Select the location, then click on 

file menu. 
 
 
(5) On the file menu select New, then 

new folder will appear. Click it 
 
 
(6) Type the name of the folder so 

that it will represent the useful 
name for your folder 

 
 
 
 
 
 
 

 
 



 
Practical Performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

1 Able to create New folders 
 
 
 
 
 

1.1 Windows Explorer is 
selected and displayed on 
the screen 

 
1.2 New folders are created 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 



 
 Product Assessment 
 
Product Specifications Assessment 
 Acceptable Needs  Adjustments Not Acceptable 
New folders are created   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 



KNOWLEDGE ASSESSMENT 
ORAL WRITTEN 

Explain the importance of creating folders  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 



 
Trade:   COMPUTER APPLICATIONS 

 
 
Level:   I 
 
 
 
 
 
 
 
 
 
 
 
Module: 1  MICROSOFT WINDOWS 95/98/2000 
 
 
Unit:  1.2  PREPARING DISKS AND ORGANIZING FILES AND FOLDERS 
  
 
[TLE]: 1.2.2  COPYING, MOVING AND DELETING FILES/FOLDERS 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
1 Preparation of Training 
 
 
Objectives 

 
At the end of this element a trainee must be able to copy, move 
and delete files/folders 
 

 
Duration 

 
1 hours 
 

 
Equipment/tools 

 
Computer table, computer, and its peripherals 
 

 
Training Materials 

 
NIL 
 

 
Teaching aids 

 
Handout 
 

 
Reference Materials 

 
Word 97 Users guide book 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
2.                   Preparation of Training     

 
 
 
 
Demonstrate and explain to the trainees how to copy, move and delete files. 
 
(1) Explain why do we copy files 
 
(2) Click start button and point to programs 
 
(3) Click windows explorer  
 
(4) Select and right click the file you want to copy, move or delete the pop-up menu will 

appear 
 
(5) From the pop-up menu click either copy, move or delete 
 
Right click on the folder you want to contain your file, and the pop-up menu will appear. 
Click paste in the case of copying 
 
NB: In the case of deleting you end up at step 5 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Information sheet (Handout) 
 
Steps: 
(1) Click start button and point to programs (Fig 1) 
(2) Click windows explorer (Fig2) 
(3) Select and right click the file you want to copy, move or delete. The pop-up menu will 

appear 
(4) From the pop-up menu click either copy, move or delete 
(5) Right click on the folder you want to contain your file, and the pop-up menu will appear. 

Click paste in the case of copying 
NB: In the case of deleting you end up at step 4 

Fig. 1 
 

Fig. 2  



Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Able to copy, move and delete 
files using the tools/devices 
stated in the range statements 
 
 
 
 
 

1.1 Windows explorer is 
selected and displayed on 
the screen. 

 
1.2 Copying, moving and 

deleting are properly done 
according to the steps 
provided 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 



 
Product Assessment 
 
Product Specifications Assessment 
 Acceptable Needs  Adjustments Not Acceptable 
1. Files are copied to another 

folder 
 
2. Files are moved from one 

folder to another 
 
3. Files are deleted from 

different folders 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 



KNOWLEDGE ASSESSMENT 
ORAL WRITTEN 

Explain the importance of copying, moving 
and deleting files  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 



 
Trade:   COMPUTER APPLICATIONS 

 
 
 
 
Level:     I 
 
 
 
Module: 1  MICROSOFT WINDOWS 95/98/2000 
 
 
 
 
Unit:   1.2  PREPARING DISKS AND ORGANIZING FILES AND 
FOLDERS 
 
 
 
 
 
Training and Leaning Element [TLE]: 1.2.3  RENAMING FILES OR 
FOLDERS 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
               Vocational Education and Training Authority         (VETA) 



 
 
Preparation of Training 
 
 
 
Objectives 

 
At the end of this element  trainee must be able to rename files 
and folders 
 

 
Duration 

 
30 min 
 

 
Equipment/tools 

 
Computer  
 

 
Training Materials 

 
NIL 
 

 
Teaching aids 

 
Information sheet 
 

 
Reference Materials 

 
Word processing users manual books 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 



2.  Preparation of Training     
 

 
 
Explain the importance of naming and renaming files or folders  
 
Steps: 
(1) Click on the start  button 
 
(2) Slide the mouse pointer to programs 
 
(3) Click windows explorer to display the disk structure 
 
(4) Right click on the file or folder you want to rename 
 
(5) From the pop-up menu click on the rename option command 
 
(6) Type in the name you want and click mouse button anywhere on the screen 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



2 Information sheet (Handout) 
In order to rename a file /folder follows the following steps. 
(1) Click on the start  button 
(2) Slide the mouse pointer to programs 
(3) Click windows explorer to display the disk structure 
(4) Right click on the file or folder you want to rename 
(5) From the pop-up menu click on the rename option command 
(6) Type in the name you want and to finish click mouse button anywhere on the screen 

 
 

 
 
 
 



 
 
Practical performance Assessment 
Direct Performance 
 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Able to rename files/folders 
 
 
 
 
 

1.1 Windows explorer is 
selected and displayed on 
the screen. 

 
1.2 Folder are renamed 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 



 
 
 
  Product Assessment 
 
Product Specifications Assessment 
 Acceptable Needs Further  

Adjustments 
Not Acceptable 

Files/folders are renamed 
 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 



KNOWLEDGE ASSESSMENT 
 
 

ORAL WRITTEN 
Why renaming files/folders  
 
Explain the procedures/steps to rename a 

folder/file 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 



Trade:   COMPUTER APPLICATIONS 

 
 
 
 
 
Level:   I 
 
 
 
 
 
 
 
Module: 1  MICROSOFT WINDOWS 95/98/2000 
 
 
Unit:   1.3 CUSTOMIZING WINDOWS ENVIRONMENT  

 
 
 

Training and Leaning Element [TLE]: 1.3.1 CHECKING DISK SPACE ON THE  
FLOPPY AND HARD DISK 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Vocational and Education and Training Authority (VETA) 



 
 2. Preparation of Training 
 
 
Learning Objectives 

 
At the end of this element,  trainee should  be able to check disk 
space available on the floppy and hard disk 
 

 
Duration 

 
30 min 
 

 
Range Statement 

 
Computer, floppy disk, and windows software 
 

 
Training Materials 

 
NIL 
 

 
Teaching aids 

 
Information sheet 
 

 
Reference Materials 

 
Introduction to Microsoft Windows 95 
 

 
Trainees 
Preparation 
 

 
Be aware of the computer room regulations 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
2. Preparation of Training     

 
Demonstrate and explain the steps to follow when checking space available on the floppy or 
hard disk the importance of checking   space should be explained 
 
 
Steps: 
(1) Click on the start  button 
(2) Point to programs 
(3) Click to windows explorer  
(4) Click the drive you want to check (Hard disk or Floppy disk) 
(5) Click file on the member 
(6) Select properties on the pull down menu appeared 
(7) Used space and free space will be displayed, and click OK to finish 

 
 



 
Information sheet (Handout) 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Information sheet (Handout) 
 
 
To  check the available space on the floppy or hard disks, use the steps below 
 
Steps: 
(1) Click start  button 
 
(2) Point to programs 
 
(3) Click to windows explorer  
 
(4) Click the drive you want to check (Hard disk or Floppy disk) 
 
(5) Click file on the member 
 
(6) Select properties on the pull down menu appeared 
 
(7) Used space and free space will be displayed, and click OK to finish 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Able to check  the disk space 
available on the floppy and 
hard disk 
 
 
 
 
 

1.1 Space available on the 
floppy disk checked 

 
1.2 Space available on the 

hard disk checked 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 



 
 Product Assessment 
Product Specifications Assessment 
 Acceptable Needs Further  

Adjustments 
Not Acceptable 

(1) Space available on the 
floppy disk seen 

 
(2) Space available in the hard 

disk seen 
 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 
KNOWLEDGE ASSESSMENT 

ORAL WRITTEN 
Explain the steps to check the space 

available on the floppy diskette 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Write down the reasons for checking 
the space on the floppy disk and hard 
disk 

 

 



 
Trade:   COMPUTER APPLICATIONS 

 
 
 
 
 
 
Level :   I 
 
 
 
Module: 1  MICROSOFT WINDOWS 95/98/2000 
 
 
Unit:   1.3 CUSTOMIZING WINDOWS ENVIRONMENT  

 
 

Training and Leaning Element [TLE]: 1.3.2 STARTING, QUITTING A 
PROGRAM  

          & SWITCHING BETWEEN PROGRAMS   
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA ) 



1 Preparation of Training 
 
 
Learning Objectives 

 
At the end of this element,  trainee must  be able to start, quit and  
switch between programs 
 

 
Duration 

 
40 min 
 

 
Range Statement 

 
Computer, Windows 95/98/2000 Software 
 

 
Training Materials 

 
NIL 
 

 
Instructional AIDS 

 
Information sheet 
 

 
Reference Materials 

 
Introduction to Microsoft Windows 95 – for distribution only 
with New PC 
 

 
Trainees Preparation 
 

 
Be aware of the computer room regulations 

 
 
 
 
 
 
 
 
 
 
 
 



 
Presentation of Training/teaching steps     

 
Demonstrate and explain how to start, quit and switching between programs 
 
You can use the Start button to start any program you want to use, such as your word processor or a 
favorite game 
 

 1. Click start button, and then point 
         Programs 
 

 2. Point to the folder, such as Accessories, that contains the program, and then click the program 
 
TIP 
You can add a program to the top of the Start menu by dragging its icon onto the Start button. 
 
What appears when you click Programs? 
The programs and folders you see when you point to programs come from several places: 
• When you set up Windows, you see several programs, such as windows Explorer and MS-DOS Prompt, and 

several folders on the Programs menu. Each folder contains programs that are grouped together for easy 
access. 

• Windows also includes the Startup folder, in which you can put programs you want to start automatically 
when you start windows. 

• When you install new programs on your computer, you may see additional folders. 
• If you upgraded from previous version of Windows, your old program groups appear as folders. 
 

 
 



Presentation of training/ teaching steps 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
To quit programs follow the following steps 
 
(1) To quit  a Program 

 Click the Close button in the upper-right comer of the window. 
 
You can run as many programs as you want at the same time. Windows makes it easy to switch 
between programs or windows. 
 
To switch between programs 

 Click the taskbar button for the program you want. 
 

 
 
 



 
2. Information sheet (hand out) 
 

 
 
The program appears In front of the other  
 
 



3. Information sheet (hand out) 
 
 
You can use the Start button to start any program you want to use, such as your word processor or a 
favorite game.  
 

 1 Click the Start button, and then point to Programs. 
 

 2 Point to the folder, such as Accessories, that contains the program, and then click the program 
 
TIP 
You can add a program to the top of the Start menu by dragging its icon onto the start button. 
 
What appears when you click Programs? 
The programs and folders you see when you point to programs come from several places: 
• When you set up Windows, you see several programs, such as windows Explorer and MS-DOS 

Prompt, and several folders on the Programs menu. Each folder contains programs that are 
grouped together for easy access. 

• Windows also includes the Startup folder, in which you can put programs you want to start 
automatically when you start windows. 

• When you install new programs on your computer, you may see additional folders. 
If you upgraded from previous version of Windows, your old program groups appear as folders. 
 

 
 
 



 
Information sheet (hand out) 
 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 



Information sheet (hand out) 
 
 
To quit programs follow the following steps 
 
(2) To quit Program 

 Click the Close button in the upper-right corner of the window. 
 
 
You can run as many programs as you want at the same time. Windows makes it easy to 
switch between programs or windows. 
 
 
To Switch between programs 

 Click the taskbar button for the program you want. 
 
 
 

 
 
 
 
 
 
 
 
 
 



Information sheet (hand out) 
 
 

 
The program appears In front of the other  

 



 
Practical performance Assessment 
Direct Performance 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Be able to start, quit and 
switch between programs 

(1) The program is started 
 
(2) Quitting the program 
 
(3) Switching between programs 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 



Product Assessment 
Product Specifications Assessment 
 Acceptable Needs Adjustments Not Acceptable 
(1) Program started 
 
 
(2) Program quitted 
 
 
(3) Different programs are 

switched on 
 
 
 
 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 



KNOWLEDGE ASSESSMENT 
ORAL WRITTEN 

1. Explain how the program is started and 
quitting 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Write down the steps for starting and 
quitting a program 

 



Trade:   COMPUTER APPLICATIONS 

 
Level :      I 
 
 
 
 
 
 
 
 
 
 
 
Module: 1  MICROSOFT WINDOWS 95/98/2000 
 
Unit:   1.3 CUSTOMIZE WINDOWS ENVIRONMENT  

 
 
 [TLE]:             1.3.3 FINDING SOMETHING ON YOUR COMPUTER AND  

CHANGING SYSTEM SETTINGS  
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Vocational Education and Training Authority (VETA)



 
1.  Preparation of Training 
 
 
Learning Objectives 

 
At the end of this element,  trainees must  be able to find 
something on the computer and change system settings 
 

 
Duration 

 
40 min 
 

 
Range Statement 

 
Computer and  Windows 95/98/2000 Software 
 

 
Training Materials 

 
NIL 
 

 
Instructional AIDS 

 
Information sheet 
 

 
Reference Materials 

 
Introduction to Microsoft Windows 95 – for distribution only with  
a new PC 
 

 
Trainees 
Preparation 
 

 
Be aware of the computer room regulations 

 
 
 
 
 
 
 
 
 
 
 
 
 



2. Presentation of Training/teaching steps     
 

Demonstrate and explain how to find something on their computer and how to change the system 
settings 
If you don’t know where a document or folder is, you can use the Find command to find and open 
it. 

 1. Click start button, and then point to Find 
 2. Click Files or Folders 

TIP 
You can also use the find command to search for a computer on the network. 

 3. Click the Named box and then type the 
           name of the file or folder you want to find. 

 4.  To specify where to search, click the arrow 
            next to the Look In box, or click Browse. 

 5.  To start the search, click Find Now. 
Changing System settings 
Using Control Panel, you can change the way Windows looks and works. 

 1. Click Start button, and then point to Setting 
 2. Click control Panel. 

TIP 
Some of the things you can use Control Panel for are changing your screen colors, installing or 
changing settings for a network  
The icons that appear in Control Panel vary depending on the hardware and software installed on 
your computer. 

 
 
 



 
2. Presentation of training/ teaching steps 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



3. Presentation of training/ teaching steps 
 

 3. Double –click an icon to see the settings you can change 
 
 

 
 

 
 
 
 
 
 
 
 



 
2. Information sheet (hand out) 
 
If you don’t know where a document or folder is, you can use the Find command to find and open 
it. 

 1. Click start button, and then point to Find 
 2. Click Files or Folders 

TIP 
You can also use the find command to search for a computer on the network. 

 3. Click the Named box and then type the name of the file or folder you want to find. 
 4.  To specify where to search, click the arrow next to the Look In box, or click Browse. 
 5.  To start the search, click Find Now. 

Changing System settings 
Using Control Panel, you can change the way Windows looks and works. 

 1. Click Start button, and then point to Setting 
 2. Click control Panel. 

TIP 
Some of the things you can use Control Panel for are changing your screen colors, installing or 
changing settings for a network  
The icons that appear in Control Panel vary depending on the hardware and software installed on 
your computer. 
 

 
  



 
3. Information Sheet (Hand out)  

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



3. Information Sheet (Hand out)  
 
 

 3. Double –click an icon to see the settings you can change 

 
 

 
 

 
 



 
Practical Performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Be able to find something 
on the computer and 
change system setting 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Finding something on the 
computer 

 
(2) Change system settings 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 
 
 



 Product Assessment 
Product/Service Specifications Assessment 
 Acceptable Needs Adjustments Not Acceptable 
(1) Something was looked after 

found 
 
 
(2) System settings changes 

affected 
 
 
 
 
 
 
 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 



KNOWLEDGE ASSESSMENT 
ORAL WRITTEN 

1. Why changing system settings 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Write down the steps to follow when  
       changing your system settings 

 



Trade: 1  COMPUTER APPLICATIONS 

 
 
 
Level:             I 
 
 
 
 
 
 
 
 
Module: 1  MICROSOFT WINDOWS 95/98/2000 
 
Unit:   1.3 CUSTOMIZE WINDOWS ENVIRONMENT  
 
 
 [TLE]:          1.3.4   VIEW WHAT IS ON YOUR COMPUTER 

 AND GETTING HELP  
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA)



 
 
1 Preparation of Training 
 
 
Learning Objectives 

 
At the end of this element,  trainees must  be able to view what 
is on their computers and using the windows Help 
 

 
Duration 

 
20 min 
 

 
Range Statement 

 
Computer and  Windows 95/98/2000 Software 
 

 
Training Materials 

 
NIL 
 

 
Instructional AIDS 

 
Information sheet 
 

 
Reference Materials 

 
Introduction to Microsoft Windows 95 – for distribution only 
with  a new PC 
 

 
Trainees Preparation 
 

 
Be aware of the computer room regulations 

 
 
 
 
 
 
 
 
 
 
 
 



 
2 Presentation of Training/teaching steps     
Demonstrate and explain the important items appear on the desktop when you start windows. The following 
are the four important ones 

 My computer  
       Double-click this icon to see your computer’ contents and manage your files. For more information, see 
Chapter 2, “Beyond the Basics”. 

 Network Neighborhood 
Double-click this icon to see available resources on the network, if your computer is or can be connected 
to one. For more information, see Chapter 3, “Introducing Network.” 

 Recycle Bin 
The recycle Bin is temporary storage place for deleted files. You can use it to retrieve files deleted in 
error. For more information, see chapter 2, “Beyond the Basic” 

 Start button 
You can click the Start button on the taskbar to start a program, open a document, change system settings, 
get help, find items on your computer, and more. For more information, see Chapter 1, “The Basics” 

Getting Help 
Online Help is essential to learning and using Windows. These are two kinds of Help: Help about a specific 
procedure and help that gives you information about what you see on your screen. 
Steps. 
(1) Click the Start button, and then click Help. Fig 1 
(2) The list of Help topics appears. You can use the tabs in help to search for information in several ways. Fig 

2 
 
When you open help by using the Start menu, or the Help menu in My Computer or Windows explorer, you 
see help for Windows in general. If you use the Help menu in a program, such as WordPad, Paint, or 
Microsoft Word, the Help you see is for that program. 

 
 



 
Presentation of Training/teaching steps  
 
 

 
 



2. Presentation of Training 
 

 
To find help through the contents follow these steps. 
 
 
 
 
(1) Click the Contents tab to find topics grouped by subject, and then follow the instructions on your 

screen. 
 
(2) To return to the list of topics, click Help Topics. 
 
TIP 
Some Help topics contain green underlined text. You can click the green text to see a definition of the 
term. 
 
To find help through the under follow these steps 
 
(1) Click the index tab to find specific topics listed alphabetically and then follow the instructions on 

your screen. 
 
(2) To return to the list of topics, click Help Topics. 
 
 
TIP  
To scroll through the Help index, type the first few letters of the word you want to search for. The 
index is arranged just like a book index. If you don’t find the entry you want, try another entry. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
2. Presentation of Training/ teaching steps 

 
To find help topics containing a word or phase follow these steps 

 Click the Find tab to find all the topics that contain a specific word or phase, and then 
follow the instructions on your screen. 

 
 To return to the list of topics, click help Topics. 

 
To find help on a specific item follow these steps 
 

 For information about an item in a dialog box, click  ?         and then click the item. 
 A pop-up explanation appears, Click to make it disappear 

TIP 
You can also use your right mouse button to click an item on the screen. Then click the 
“What’s This? command 
 

 
 
 
 



 
3. Information sheet (hand out) 
 
The important items appears on the desktop when you start windows are the four ones mentioned below 

 My computer  
     Double-click this icon to see your computer’ 
     contents and manage your files. For more 
     information, see Chapter 2, “Beyond the Basics”. 

 Network Neighborhood 
Double-click this icon to see available resources on the network, if your computer is or can be 
connected to one. For more information, see Chapter 3, “Introducing Network.” 

 Recycle Bin 
The recycle Bin is temporary storage place for deleted files. You can use it to retrieve files deleted in 
error. For more information, see chapter 2, “Beyond the Basic” 

 Start button 
You can click the Start button on the taskbar to start a program, open a document, change system 
settings, get help, find items on your computer, and more. For more information, see Chapter 1, 
“The Basics” 

Getting Help 
Online Help is essential to learning and using Windows. These are two kinds of Help: Help about a 
specific procedure and help that gives you information about what you see on your screen. 
Steps. 
(1) Click the Start button, and then click Help. Fig 1 
(2) The list of Help topics appears. You can use the tabs in help to search for information in 

several ways. Fig 2 
When you open help by using the Start menu, or the Help menu in My Computer or Windows 
explorer, you see help for Windows in general. If you use the Help menu in a program, such as 
WordPad, Paint, or Microsoft Word, the Help you see is for that program. 

          



 
 
3.     Information sheet (hand out) 
 
To find help through the contents follow these steps. 
(1) Click the Contents tab to find topics grouped by subject, and then follow the instructions 

on your screen. 
 
 
(2) To return to the list of topics, click Help Topics. 
TIP 
Some Help topics contain green underlined text. You can click the green text to see a 
definition of the term. 
 
To find help through the under follow these steps 
 
 
 
 
 
(3) Click the index tab to find specific topics listed alphabetically and then follow the 

instructions on your screen. 
 
 
(4) To return to the list of topics, click Help Topics. 
 
TIP  
To scroll through the Help index, type the first few letters of the word you want to search 
for. The index is arranged just like a book index. If you don’t find the entry you want, try 
another entry 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
3. Information sheet (hand out) 
 
 
To find help topics containing a word or phase follow these steps 
 

 Click the Find tab to find all the topics that contain a specific word or phase, and then 
follow the instructions on your screen. 

 To return to the list of topics, click help Topics. 
To find help on a specific item follow these steps 

 For information about an item in a dialog box, click and then click the item. 
 A pop-up explanation appears, Click to make it disappear 

 
TIP 
You can also use your right mouse button to click an item on the screen. Then click the 
“What’s This? command. 
 

 
 
 
 



 
Practical Performance Assessment 
Direct Performance 
 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Be able to view what is 
on the computer and use 
Windows help 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Start Windows and the items 
seen 

 
(2) Find Help through contents 
 
(1) Find Help through the index 
 
(2) Find help topics containing a 

word or phase 
 
(3) Find Help on a specific item 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 



Product Assessment 
Assessment Product/Service Specifications 

Acceptable Needs Adjustments Not Acceptable 
(1) Items seen 
 
(2) Help through contents done 
 
(3) Help through index done 
 
(4) Help through specific item 

done 
 
(5) Find Help topics containing 

a word or phrase 
 
 
 
 
 
 
 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 



KNOWLEDGE ASSESSMENT 
ORAL WRITTEN 

(1) What is the use of Help, and give an 
example? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Write down the most important four 
items appears on the desktop, when you 
start window 

 
(2) Mention the steps to find help through 

Index, specific item and a word or 
phase 

 

 



Trade: 1  COMPUTER APPLICATIONS 

 
 
 
Level:                                           I 
 
 
 
 
 
 
Module:  2 WORD PROCESSING PROGRAMS 
 
Unit:   2.2 WORKING WITH DOCUMENTS  

 
 

[TLE]: 2.2.1 ZOOM, UNDO AND REPEAT 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



 
 
1 Preparation of Training 
 
 
Learning Objectives 

 
At the end of this element,  trainees must  be able to zoom a page 
on the screen, undo and repeat(redo) the recent actors 
 

 
Duration 

 
20 min 
 

 
Range Statement 

 
Computer and  Windows 95/98/2000 Software 
 

 
Training Materials 

 
NIL 
 

 
Instructional AIDS 

 
Information sheet 
 

 
Reference Materials 

 
Microsoft Word 97  Users guide 
 

 
Trainees Preparation 
 

 
Be aware of the regulations guiding the computer room  

 
 
 
 
 
 
 
 
 
 
 
 



 
2 Presentation of Training/teaching steps  
    
Demonstrate and explain to the trainee the procedures for zooming, undoing and repeating recent 
actions. 
To zoom page on screen 
Steps:  
(1) From the view menu choose the zoom command. 
(2) Press enter or choose OK (see Fig 1) to zoom a document using the zoom control icon 
(3) Use the zoom control  button on the standard toolbar to quickly zoom to a certain settings (Fig 2) 
To Undo and Repeat follow the following steps: 
(1) from the Edit menu choose the undo command or press ctrl+Z or click on the undo button on the 

standard toolbar. 
(2) From the edit menu select Repeat or press F4 or click on the Redo button on the standard toolbar 

 
 

 
 

 
To undo or  move the mouse pointer over a downward facing arrowhead to the right of the  
repeat a  undo or redo buttons on the standard toolbar and click the left mouse button. 
specific  pull the mouse pointer down the list until the number of items required are 
number of   selected and click the left mouse button again or press enter 
commands  if you decide that you do not want to undo or repeat anything but the list has actions, 
or  already been selected press Escape to get out of it. You can also get out of the  
typing  list by moving the mouse pointer onto your document and clicking the left  
changes  mouse button  
 



 
Practical Performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Be able to zoom a page 
on the screen, Undo and 
Repeat (redo) the recent 
actions 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) The page on the screen is 
zoomed 

 
 
(1) The last action performed is 

seen (undo) 
 
(2) Repeat action is performed 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 



Product Assessment 
Assessment Product/Service Specifications 

Acceptable Need Adjustments Not Acceptable 
(1) Page on the screen is 

zoomed accordingly 
 
(2) The previous last job done is 

seen on the screen 
 
(3) The document is repeated 
 
 
 
 
 
 
 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 



KNOWLEDGE ASSESSMENT 
ORAL WRITTEN 

1. Explain the reason for zooming a page 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Why do we undo recent actions 
 
(2) Explain the steps will need to zoom a 

page on the screen to 50% 
 

 



Trade:   COMPUTER APPLICATIONS 

 
 
 
Level:    I 
 
 
 
 
 
 
 
Module:  2 WORD PROCESSING PROGRAMS 
 
 
Unit:   2.2 WORKING WITH DOCUMENTS  

 
 
 [TLE]:         2.2.2 SPELL CHECK AND GRAMMAR 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



 
 
2 Preparation of Training 

 
 
 
Learning Objectives 

 
At the end of this element,  trainees must  be able check spelling 
errors and grammar 
 

 
Duration 

 
30 min 
 

 
Equipment /tools 

 
Computer  
 

 
Training Materials 

 
NIL 
 

 
Teaching aids 

 
Handouts 
 

 
Reference Materials 

 
Word processing books-user manual 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
2 Preparation of Training     

 
 
 
 
 
 
(1) Explain the important of spell checking 
 
 
 
(2) Click on the tools drop down menu and select the options command 
 
 
 
 
(3) Click on the spelling and grammar tab  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
3. Information sheet (hand out) 
 
The word processing program will display incorrect spell words as underlined in red.  
 
You can run a spell checker program at any time by clicking on the spelling icon in the 
standard tools bar (or pressing F7) You can also check the grammar used within your 
document. 
 
To disable automatic spell checking follow the following steps 
 
(1) Click  on the tools drop down menu and select the options command 
 
(2) Click on the Spelling and grammar tab 
 
(3) Remove the check next to check spelling as you type 
 

 
 

 



 
3.    Information sheet (hand out) 
 
 
 
 
To disable grammar check follow the  following steps 
 
(1) Click on the tools drop down menu and select options command 
 
(2) Click on the spelling and grammar tab 
 
(3) Remove the check grammar as you type 
 
To check the grammar in a document follow the following steps 
 
(1) Position the insertion point at the location in your document where you wish to 

begin the grammar check. 
 
(2) From the tools menu, select the spelling and grammar command to display the 

spelling and grammar dialog box (or press F7)  
 
 
 
 
 
 
 
 
 



 
Practical Performance Assessment 
Direct Performance: 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Be able to check spelling 
errors and grammar 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.1 Spelling are checked correctly 
 
1.2 Grammar is properly checked 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 



Product Assessment: 
 

Assessment Product/Service Specifications 
Acceptable Needs Adjustments Not Acceptable 

(1) The spelling are checked 
properly 

 
(2) The grammar is checked 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 



KNOWLEDGE ASSESSMENT 
 

ORAL WRITTEN 
1. Explain the steps to follow when 

checking spelling 
 
 
  Explain the steps to follow when checking 

grammar 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 



Trade:   COMPUTER APPLICATIONS 

 
Level :   I 
 
 
 
 
 
 
 
 
 
 
 
Module:  2 WORD PROCESSING PROGRAMS 
 
 
Unit:   2.2 WORKING WITH DOCUMENTS  

 
 
 [TLE]: 2.2.3 THE THESAURUS 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 
 



 
 
1 Preparation of Training 
 
 
 
Learning Objectives 

 
At the end of this element,  trainees must  be able to look up 
synonyms and antonyms 
 

 
Duration 

 
20 min 
 

 
Range Statement 

 
Computer table, computer and peripherals, voltage stabilizer,  
Uninterrupted Power Supply (UPS), printing papers, air 
conditioner and required software 
 

 
Training Materials 

 
NIL 
 

 
Instructional  aids 

 
Computer, Information sheet 
 

 
Reference Materials 

 
Microsoft Word 97 Users guide 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
2 Presentation of Training/teaching steps  
 
Explain the important of using thesaurus as a proofing tools within word 97/2000 
 
Steps: 
(1) Select the word which you want to find a synonym or antonyms for. 
(2) Either from the Tools menu select language command and then from the sub-menu displayed select 

Thesaurus command or press shift+F7 to display the thesaurus dialogue box 
(3) A list of suggested synonyms will be displayed in the replace with synonym list box. Select a 

different meaning from the meaning list box if you want to display synonyms that have  different 
meanings 

(4) Choose the related word or Antonyms option from the meanings list box to find any related word or 
antonyms. Any related words will be displayed in the replace with related words list box, and the 
antonyms will appear in the antonyms list box  

(5) Select the look-up button to find other meanings or and synonyms. 
(6) If you want to replace a word in your document select the replacement word form the replace with 

synonym list box choose the replace button when the word you selected appears in the replace with 
text box. 

(7) If you do not want to change the word in the document, select cancel button. 
 

 
 
 
 
 
 
 
 
 
 



 
Information sheet (hand out) 
 
The word processing program will display incorrect spell words as underlined in red.  
 
You can run a spell checker program at any time by clicking on the spelling icon in the 
standard tools bar (or pressing F7) You can also check the grammar used within your 
document. 
 
To disable automatic spell checking follow the following steps 
 
(1) Click  on the tools drop down menu and select the options command 
 
(2) Click on the Spelling and grammar tab 
 
(3) Remove the check next to check spelling as you type 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
1. Information sheet (hand out) 
 
 
 
Steps: 
(1) Select the word which you want to find a synonym or antonyms for. 
(2) Either from the Tools menu select language command and then from the sub-menu 

displayed select Thesaurus command or press shift+F7 to display the thesaurus 
dialogue box 

(3) A list of suggested synonyms will be displayed in the replace with synonym list box. 
Select a different meaning from the meaning list box if you want to display synonyms 
that have  different meanings 

(4) Choose the related word or Antonyms option from the meanings list box to find any 
related word or antonyms. Any related words will be displayed in the replace with 
related words list box, and the antonyms will appear in the antonyms list box  

(5) Select the look-up button to find other meanings or and synonyms. 
(6) If you want to replace a word in your document select the replacement word form the 

replace with synonym list box choose the replace button when the word you selected 
appears in the replace with text box. 

(7) If you do not want to change the word in the document, select cancel button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Practical Performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

1 Able to look up 
synonyms or antonyms 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1.1 The word is correctly 

highlighted  
 
1.2 A list of suggested synonyms is 

displayed 
 
1.3 The related word or antonyms is 

selected 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 



Product Assessment 
 

Assessment Product/Service Specifications 
Acceptable Need Adjustments Not Acceptable 

Synonyms or antonyms are 
correctly performed 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 
KNOWLEDGE ASSESSMENT 

ORAL WRITTEN 
(1) Explain why it is important to use 

thesaurus? 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Write down the steps or procedure to 
find a synonyms or antonyms 

 
 

 



Trade:   COMPUTER APPLICATIONS 

 
 
Level:    I 
 
Module:  2 WORD PROCESSING PROGRAMS 
 
Unit:   2.2 WORKING WITH DOCUMENTS  
 
[TLE]:             2.2.4 BOLD, UNDERLINE AND ITALICS 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



 
1 Preparation of Training 
 
 
Learning Objectives 

 
At the end of this element,  trainees must  be able to Bold, 
Underline the text and make it Italic 
 

 
Duration 

 
20 min 
 

 
Range Statement 

 
Computer table, computer and peripherals, voltage stabilizer,  
Uninterrupted Power Supply (UPS), printing papers, air 
conditioner and required software 
 

 
Training Materials 

 
NIL 
 

 
Instructional  aids 

 
Information sheet 
 

 
Reference Materials 

 
Microsoft Word 97 Users guide 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



2 Presentation of Training/teaching steps  
    
1. Explain to the trainee the importance of Bold, Underline and Italics 
 
Steps: 
 
(1) Select the text you wish to format as Bold, underline or Italics 
 
(2) Click on the Bold, or underline or Italics icon in the formatting toolbar. 
 
(3) Click outside the selected text to remove the shade 
 
To change the text that you enter (when start typing your text) 
 
(1) Place the insertion point where you wish to insert bold or underline or Italic text. 
 
(2) Click on the Bold or underline or italics icon in the formatting toolbar 
 
 
Bold and Italics 
Bold keyboard shortcut 
-  ctrl +B 
Italic keyboard shortcut 
- ctrl +I 
- Formatting toolbar shortcuts 
 

 
 
 
 
 
 
 



 
1 Preparation  of Training  
 
 
 
 
 
To vary the type of underlining applied to selected text follow the following steps. 
 
 
 
 
(1) Select the text that you wish to underline 
 
 
 
 
 
(2) Click on the format drop down menu and select font command 
 
 
 
 
(3) Click on the down arrow next to underline option. 
 
 
 
 
This will display a drop down list of options as illustrated. 
 
 
 
 
(4) Select the required option and then close the dialogue box 
 
 
 
 
 
 
 
 
 
 
 
 
 



3. Information sheet (hand out) 
  
(1) Select the text you wish to format as Bold, underline or Italics 
(2) Click on the Bold, or underline or Italics icon in the formatting toolbar. 
(3) Click outside the selected text to remove the shade 
To change the text that you enter (when start typing your text) 
(1) Place the insertion point where you wish to insert bold or underline or Italic text. 
(2) Click on the Bold or underline or italics icon in the formatting toolbar 
 
To vary the type of underlining applied to selected text follow the following steps. 
(1) Select the text that you wish to underline 
(2) Click on the format drop down menu and select font command 
(3) Click on the down arrow next to underline option. This will display a drop down list of 

options as illustrated. 
(4) Select the required option and then close the dialogue box. 
Bold and Italics 
Bold keyboard shortcut 
-  ctrl +B 
Italic keyboard shortcut 
- ctrl +I 
Formatting toolbar shortcuts 
 

            
 



 
Practical Performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

1 Should be able to Bold, 
underline and make text 
italic 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1. The text is highlighted correctly 

2. The text is bolded 

3. The text is underlined 

4. The text is changed to Italic 

5. Different type of underlines are 
selected. 

 
 
 
 
 
 

   

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 



 
Product Assessment 
 

Assessment Product/Service Specifications 
Acceptable Need Adjustments Not Acceptable 

1. Text is Bold 
 
2. Text is underlined 
 
3. Text is appear in Italics 
 
4. Different types of liens are 

produced 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



KNOWLEDGE ASSESSMENT 
 

ORAL WRITTEN 
(1) Explain the importance of Bolding, 

underlining and making the text Italics 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Write down the steps Bold and to make 
the text Italics 
 
(1) Explain the steps to follow to produce 

Varying types of underline 
 
 

 



Trade:   COMPUTER APPLICATIONS 

 
Level:   I 
 
 
Module:  2 WORD PROCESSING PROGRAMS 
 
 
 
Unit:   2.2 WORKING WITH DOCUMENTS  

 
 
 
 

Training and Leaning Element [TLE]: 2.2.5  OPENING, SAVING AND 
CLOSING A FILE 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



 
1.  Preparation of Training 
 
 
 
 
Learning Objectives 

 
At the end of this element, the trainees must  be able to 
(1) Open and save a file  
(2) Close a file 
 

 
Duration 

 
40 min 
 

 
Range Statement 

 
Computer table, computer and peripherals, voltage stabilizer,  
Uninterrupted Power Supply (UPS), printing papers, air 
conditioner and required software 
 

 
Training Materials 

 
NIL 
 

 
Instructional  aids 

 
Information sheet 
 

 
Reference Materials 

 
Microsoft Word 97 Users guide 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
2. Preparation  of Training  
 
 
 
 
 
Demonstrate and explain the importance of saving, editing and closing a file  
 
 
 
 
To open a file follow the following steps: 
 
(1) From the file menu, choose the open command the open dialogue is displayed. 
 
(2) Use the look in drop sown menu to select the drive or folder that contains the file 

you want 
 
 
(3) To open the file you want either double click on the filename, or select the file name 

by clicking on it, and then click on the open button. 
Closing a file 
(1) select close from the File drop down menu or press ctrl+F4 
 
 
 
 
 
Note: If you want to close the document without saving it word 97 will display a 
dialogue box asking if you want to save any of the changes you made to the document. 
(2) Or click on the close icon displayed at the top-right corner of the document window  
 
 
 
 
 
 
 
 
 
 
 



 
 
1. Preparation  of Training  
 
 
 
 
 
To save a file 
(1) From the file menu choose the save or the save as command 
 
 
 
(2) Select the drive or folder you want to save in 
 
 
 
(3) Type the name in the Filename box 
 
 
 
(4) To change the file type, click the arrow next to save as Type, and then click the type you 

want 
 
 
 
 
(5) Click Save 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
3 Information sheet (hand out) 
Demonstrate and explain the importance of saving, editing and closing a file  
To open a file follow the following steps: 
(4) From the file menu, choose the open command the open dialogue is displayed. 
(5) Use the look in drop shown menu to select the drive or folder that contains the file you want 
(6) To open the file you want either double click on the filename, or select the file name by 

clicking on it, and then click on the open button. 
Closing a file 
(1) select close from the File drop down menu or press ctrl+F4 
Note: If you want to close the document without saving it word 97 will display a dialogue box 
asking if you want to save any of the changes you made to the document. 
(2) Or click on the close icon displayed at the top-right corner of the document window  
 

 
 

 
 



3.          Information sheet (hand out) 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



3.          Information sheet (hand out) 
 
To save a file 
(1) From the file menu choose the save or the save as command 
 
(2) Select the drive or folder you want to save in 
 
(3) Type the name in the Filename box 
 
(4) To change the file type, click the arrow next to save as Type, and then click the type you 

want 
(5) Click Save 
 

                
 

 
 
 
 



 
Practical Performance Assessment 
Direct Performance 
 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

1 Should be able to open, 
save and close a file 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
(1) The file is opened accordingly 

(2) The New file is saved 

(3) The file is closed 

   

 
KEY: I - Has started but need further experience 



 II - Competent but with supervision 
 III - Competent unaided 
 Product Assessment 
 

Assessment Product/Service Specifications 
Acceptable Need Adjustments Not Acceptable 

1. File is opened 
 
2. File is saved 
 
3. File is closed 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 
 
 

KNOWLEDGE ASSESSMENT 
 
 

ORAL WRITTEN 
(1) Explain why do we save documents? 
 
(1) What is the difference between saving 

the work in the Hard disk and floppy 
disk 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Write down the steps to follow when:- 
(1) Saving a new file 
 
(2) Opening an existing file 
 
(3) Closing the file 
 
 

 
 



 
1 Preparation of Training 
 

 
Learning Objectives 

 
At the end of this element, the trainees must  be able to change the 
direction of the text 
 

 
Duration 

 
30 min 
 

 
Equipment/tools 

 
Computer  
 

 
Training Materials 

 
NIL 
 

 
Teaching  aids 

 
(Handout) Information sheet 
 

 
Reference Materials 

 
Word processing books – user manual 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



3. Information sheet (Hand out)  
 
 
 
 
 
(1) Explain the importance of changing text direction 
 
 
 
 
(2) Select the text you wish vertically oriented 
 
 
 
(3) Click on the format drop down menu, and select the text direction command. 
 
 
 
(4) Select the required orientation and then click OK button 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
3.   Information sheet (Hand out)  
 
In order to change the text direction follow the following steps 
 
(1) Select the text you wish vertically oriented 
 
(2) Click on the format drop down menu, and select the text direction command. 
 
(3) Select the required orientation and then click OK button 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 



Practical Performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

1 Be able to change the 
direction of the text 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) The text is selected properly 

(2) The text is changed 

 

 

 

   

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 



Product Assessment 
 

Assessment Product/Service Specifications 
Acceptable Need Adjustments Not Acceptable 

The text is changed according to 
the specification or instruction 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



KNOWLEDGE ASSESSMENT 
ORAL WRITTEN 

(1) What is the advantages of changing text 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 



Trade:   COMPUTER APPLICATIONS 

 
 
Level:    I 
 
 
 
 
 
 
Module:  2 WORD PROCESSING PROGRAMS 
 
 
Unit:   2.2 WORKING WITH DOCUMENTS  

 
 

Training and Leaning Element [TLE]: 2.2.7 CHANGING CASE 
 

 
 

 
 
 
 
 
 

 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



 
1 Preparation of Training 
 
 
 

 
Learning Objectives 

 
At the end of this element, the trainees must  be able to change 
case 
 

 
Duration 

 
30 min 
 

 
Equipment/tools 

 
Computer  
 

 
Training Materials 

 
NIL 
 

 
Teaching  aids 

 
Information sheet 
 

 
Reference Materials 

 
Word processing users manual books  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
2.   Information sheet (Hand out)  
 
(1) Explain the importance of changing case 
 
(2) Select the text that you wish to change case of 
 
(3) From the format menu, select change case to display the change case dialogue box 
 
(4) Choose from the list of options, e.g. Sentence case, lower case, UPPER CASE, Tittle 

Case or toGGLE Case 
 
(5) Select OK or Press enter 
 
 
 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
3. Information sheet (Hand out)  
 
 
In order to change text case follow the following steps:-  
 
(1) Select the text that you wish to change case of 
 
(2) From the format menu, select change case to display the change case dialogue box 
 
(3) Choose from the list of options, e.g. Sentence case, lower case, UPPER CASE, Tittle 

Case or toGGLE Case 
 
(4) Select OK or Press enter 
 
 
Changing  Case 
 
• From the Format menu, select Change Case 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Practical Performance Assessment 
Direct Performance 
 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

1 Be able to change case 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.1 The text is properly selected 

1.2 The text case is properly 
changed 

   

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 



Product Assessment 
 

Assessment Product/Service Specifications 
Acceptable Need Adjustments Not Acceptable 

The change case is done   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 



 
KNOWLEDGE ASSESSMENT 

ORAL WRITTEN 
(1) Why change case is necessary  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 



Trade: 1  COMPUTER APPLICATIONS 

 
 
 
 
Level:   I 
 
 
 
 
 
 
 
 
 
 
 
 
Module:  2 WORD PROCESSING PROGRAMS 
 
 
Unit:   2.2 WORKING WITH DOCUMENTS  

 
 
 [TLE]: 2.2.8 DROP CAPS 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



 
1 Preparation of Training 
 

 
Learning Objectives 

 
At the end of this element trainees must  be able to perform drop 
capping 
 

 
Duration 

 
30 min 
 

 
Equipment/tools 

 
Computer  
 

 
Training Materials 

 
NIL 
 

 
Teaching  aids 

 
Information sheet 
 

 
Reference Materials 

 
Word processing users manual books  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
2 Information sheet (Hand out)  
 
 
(1) Explain the importance of drop cap. 
 
(2) Place the insertion point within the paragraph that you wish to start drop case 
 
(3) From the format menu select drop cap to display the drop cap dialogue box 
 
(4) You can then  select  from one of the following 
 
(5) Select OK or Press enter. 
Drop Caps 

 
 
 
 
 
 
 
 
 
1. None–No dropped cap 
 
2. Dropped- will insert a drop cap into the document of the size specified 
 
3. In margin- Inserts drop cap into the margin, show as hanging indent 
 
 
 



 
3.   Information sheet (Hand out)  
 
Drop caps are used to draw attention to the beginning of a chapter or other section text. 
This feature allows you to insert a large letter at the beginning of the text which drops 
down alongside the next few lines of the text. Text  flows round the dropped capital letter 
as it would with an illustration 
 
Steps: 
(1) Place the insertion point within the paragraph that you wish to start drop case 
 
(2) From the format menu select drop cap to display the drop cap dialogue box 
 
(3) You can then  select  from one of the following options 

(i) None –No dropped cap 
(ii) Dropped- will insert a drop cap into the document of the size specified 
(iii) In margin- Inserts drop cap into the 

Margin, show as hanging indent 
 
 
(4) Select OK or Press enter 
 
Drop Caps 

 
 



Practical Performance Assessment 
Direct Performance 
 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

1 Must be able to perform 
drop capping 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.1 The text is properly selected  
 
1.2 The text is properly dropped  

   

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 



Product Assessment 
 

Assessment Product/Service Specifications 
Acceptable Need Adjustments Not Acceptable 

The case is dropped according 
to the instructions 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 



KNOWLEDGE ASSESSMENT 
ORAL WRITTEN 

(1) What is a drop cap 
 
(2) What are the advantages of drop cap 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 



Trade: 1  COMPUTER APPLICATIONS 

 
 
Level:   I 
 
 
 
 
 
 
Module:  2 WORD PROCESSING PROGRAMS 
 
 
Unit:   2.3 UNDERSTANDING AND CUSTOMIZING ENVIRONMENT  

 
[TLE]:             2.3.1 USING SCROLL BARS, DIALOGUE  

BOX, TOOLBARS, MOVING 
WINDOWS, SIZING WINDOWS AND 
USING MOUSE 

 
 
 
 

 
 
 
 
 

 
  

 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 
 
 



 
1 Preparation of Training 
 
 

 
Learning 
Objectives 

 
At the end of this element trainees must  be able to use scrollbars, 
dialogue box tool bars, task bar, moving windows, sizing windows 
and using mouse 
 

 
Duration 

 
40 min 
 

 
Equipment/tools 

 
Computer and application software for word processing 
 

 
Training Materials 

 
NIL 
 

 
Instructional  aids 

 
Information sheet, white board 
 

 
Reference 
Materials 

 
Introducing Microsoft windows 95- for distribution only with new 
PC  
 

 
Trainees 
preparation 

 
Be aware of the computer room regulations/rules 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 



 
2 Presentation  of Training/teaching steps 
 
Scrolling 
If a window is not large enough to display all the information, a scroll bar appears at the side and /or 
bottom of the window, you can drag the scroll box or click the scroll arrows. 
 
Using a dialog box 
Windows displays a dialog box when you must supply information or specify options or properties, for 
example, when you click the open command to open a document, a dialog box enables you to choose the 
one you want. The following is an example of another dialog box. 
Using toolbars 
 
Toolbars appear in many programs and provide quick ways to do tasks. Most toolbar buttons correspond 
to a menu command. You can find out what each button does by resting your pointer over the button: A 
box appears displaying the button name. 
Using the taskbar 
 
The taskbar, located at the bottom of your screen when you first start windows, contains the start button. 
To move the taskbar to a different edge of your screen, point to an empty part of the taskbar, and then 
drag it to the location you want. 
Moving windows 
Moving a window to a different place on the screen can make it easier to see more than one window at a 
time or see something the window is covering up. 
To move a window drag its title bar to a new location. 

 
 
 
 
 
 
 
 
 



Presentation of Training/teaching steps 
 
Sizing windows 
You can change a window’s size or shape in order to see more than one window at a time or to adjust how much of 
a window’s contents you can see. 
 
There are two methods of sizing windows: 
Use the buttons in the upper-right corner of the window 
Click this to                         do this  
Reduce (minimize) the window to a button of the taskbar 
Enlarge (maximize ) the window to fill the desktop 
Return the window to its previous size. This button appears when you maximize the window. 
Move the pointer to the window border. When the pointer changes shape, drag the border to enlarge, reduce, or 
change the shape of the window. 
Using mouse 
A mouse or other pointing device works on the principal that first you place your mouse pointer on (point to) 
something on your screen, and then you click with a mouse button to perform an action on that item. 
Note: Windows documentation assumes you have a mouse and are right-handed; if you are left-handed, you can 
switch left and right mouse buttons. For information, look up “switching, mouse buttons” in the help index. Also, if 
you use a pen device, a mouse “click” corresponds to a pen “tap”. 
As you move your mouse on a flat surface, the pointer moves on your screen. If you run out of room, pick up the 
mouse and place it in another spot. 
To point, move the mouse until the tip of the pointer is over the item or area you want to point to. Then you can do 
the following: 
Click  
Action            Description 
Click: press and release the left mouse button on 
Double click: quickly press and release the left mouse button twice 
Click with the right mouse button: Press and release the right mouse button once. A shortcut menu appears. 
 

 



 
3.   Information sheet (Hand out)  
 
Scrolling 
If a window is not large enough to display all the information, a scroll bar appears at the side and /or 
bottom of the window, you can drag the scroll box or click the scroll arrows. 
 
Using a dialog box 
Windows displays a dialog box when you must supply information or specify options or properties, for 
example, when you click the open command to open a document, a dialog box enables you to choose the 
one you want. The following is an example of another dialog box. 
 
Using toolbars 
Toolbars appear in many programs and provide quick ways to do tasks. Most toolbar buttons correspond 
to a menu command. You can find out what each button does by resting your pointer over the button: A 
box appears displaying the button name. 
Using the taskbar 
The taskbar, located at the bottom of your screen when you first start windows, contains the start button. 
To move the taskbar to a different edge of your screen, point to an empty part of the taskbar, and then 
drag it to the location you want. 
Moving windows 
Moving a window to a different place on the screen can make it easier to see more than one window at a 
time or see something the window is covering up. 
To move a window drag its title bar to a new location. 
 

  
 
 
 
 
 
 
 



3. Information sheet (Hand out)  
 
 Sizing windows 
You can change a window’s size or shape in order to see more than one window at a time or to adjust how 
much of a window’s contents you can see. 
There are two methods of sizing windows: 
Use the buttons in the upper-right corner of the window 
Click this to                         do this  
Reduce (minimize) the window to a button of the taskbar 
Enlarge (maximize ) the window to fill the desktop 
Return the window to its previous size. This button appears when you maximize the window. 
 
Move the pointer to the window border. When the pointer changes shape, drag the border to enlarge, 
reduce, or change the shape of the window. 
 
Using mouse 
A mouse or other pointing device works on the principal that first you place your mouse pointer on (point 
to) something on your screen, and then you click with a mouse button to perform an action on that item. 
 
Note: Windows documentation assumes you have a mouse and are right-handed; if you are left-handed, 
you can switch left and right mouse buttons. For information, look up “switching, mouse buttons” in the 
help index. Also, if you use a pen device, a mouse “click” corresponds to a pen “tap”. 
As you move your mouse on a flat surface, the pointer moves on your screen. If you run out of room, pick 
up the mouse and place it in another spot. 
To point, move the mouse until the tip of the pointer is over the item or area you want to point to. Then 
you can do the following: 
Click  
Action            Description 
Click: press and release the left mouse button on 
Double click: quickly press and release the left mouse button twice 
Click with the right mouse button: Press and release the right mouse button once. A shortcut menu appears. 

 



Practical Performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

1 Be able to use scroll bars, 
dialogue box, toolbars, 
taskbar, moving 
windows, sizing 
windows and using 
mouse 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Scrollbar used 

(2) Dialogue box used 

(3) Toolbars are used 

(4) Taskbar used 

(5) Windows moved 

(6) Windows sized 

(7) Mouse used  

   

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 
 



Product Assessment 
 

Assessment Product/Service Specifications 
Acceptable Need Adjustments Not Acceptable 

(1) Scrollbar used 

(2) Dialogue box seen and used 

(3) Toolbars seen and  used 

(4) Taskbar used and seen 

(5) Windows moved 

(6) Windows sized 

(7) Mouse used 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 
KNOWLEDGE ASSESSMENT 
 

ORAL WRITTEN 
(1) Explain how to use a dialogue box 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) What is the use of scrollbar? 
 
(2) What is the difference between 

Toolbars and Taskbar? 
 
(3) Explain how you can size a window 
 

 



Trade: 1  COMPUTER APPLICATIONS 

 
 
 
Level :     I 
 
 
 
 
 
 
 
Module:  2 WORD PROCESSING PROGRAMS 
 
Unit:   2.3 WORKING WITH TABLES AND COLUMNS  
 
 [TLE]:             2.3.2  INSERTING TABLE AND CHANGING  

COLUMN WIDTH  
 

 
 
 

 
 
 
 
 

 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



 
1 Preparation of Training 
 

 
Learning Objectives 

 
At the end of this element trainees must be able to insert table 
using the toolbar and insert table command. Change he column 
width. 
 

 
Duration 

 
30 min 
 

 
Range statements 

 
Computer and word processing software  
 

 
Training Materials 

 
NIL 
 

 
Instructional  aids 

 
Information sheet 
 

 
Reference Materials 

 
Microsoft Word 97 users guide 
 

 
Trainees preparation 

 
Be aware of the computer room regulations 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
2 Presentation  of Training/teaching steps 
 
 
 
 
 
Explain and demonstrate how to insert table and change column width 
 
(1) Position the insertion point where you want to insert the table 
 
(2) Click the table button on the toolbar 
 
(3) On the table button grid drag the mouse to select the number of columns and rows you 

want the new table to have 
 
 
The number of columns and rows you select is indicated at the bottom of the grid. For 
example if you select 2 rows and 3 columns “2x3” table appear at the bottom of the grid 
(4) Release the mouse button to insert the table 
The table consists of rows and columns of boxes called cells. On the screen, word uses dotted gridlines to 
mark the boundaries of the table and end- of –cell marks to show where the text will appear in a cell. These 
items don’t appear in the printed version of your document. (If you don’t see the gridlines, choose Gridlines 
from the Table menu; if you don’t see end-of-cell marks, click the Show/Hide button on the Standard toolbar) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
3 Presentation  of Training/teaching steps 
 
To insert a table using the insert table command. 
 
(1) Position the insertion point where you want to insert the table 
 
(2) From the table menu, choose insert table (ALT A,I) 
 
(3) In the number of columns box type or select a number indicating how many columns you 

want. If you want to set the number of rows and the widths now, you can do so in the 
appropriate boxes. If you are not sure what your requirements are, you can do so in the 
appropriate boxes. If you are not sure what your requirements are, you  can accept the 
default settings (one row with columns of equal widths) Later, you can add rows and adjust 
columns widths to set your needs 

(4) Choose the OK button 
 
To change column width: 
 
(1) Select entire table 
 
(2) From table menu, choose cell Height and width. 
 
 
(3) Select the column tab, and then choose the auto fit button. 
 
To change the columns with different width, just drag the column’s boundary 
 
 

 
 
 
 



 
Information sheet (Hand out)  
 
 
 
 
 
 
 
To insert a table using the insert table command 
(1) Position the insertion point where you want to insert the table 
 
(2) From the table menu, choose insert table (ALT A,I) 
 
(3) In the number of columns box type or select a number indicating how many columns 

you want.  
 
If you want to set the number of rows and the widths now, you can do so in the appropriate 
boxes. If you are not sure what your requirements are, you can do so in the appropriate 
boxes. If you are not sure what your requirements are, you  can accept the default settings 
(one row with columns of equal widths) Later, you can add rows and adjust columns widths 
to set your needs 
 
(4) Choose the OK button 
 
To change column width: 
(1) Select entire table 
(2) From table menu, choose cell Height and width. 
(3) Select the column tab, and then choose the auto fit button. 
To change the columns with different width, just drag the column’s boundary 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Information sheet (Hand out)  
 
To insert a table using the insert table command 
(1) Position the insertion point where you want to insert the table 
 
(2) Click the table button on the Toolbar 
 
(3) On the table button grid drag the mouse to select the number of columns and rows 

you want the new table to have. 
 
 
The number of columns and rows you select i
example if you select 2 rows and 3 columns “2x
 
(4) Release the mouse button to insert the table 
 
The table consists of rows and columns of boxes called 
mark the boundaries of the table and end- of –cell marks 
items don’t appear in the printed version of your do
Gridlines from the Table menu; if you don’t see end-o
Standard toolbar) 
 
 
 

 
 

 

 

Drag over the grid to select the 
number of rows and columns for
s indicated at the bottom of the grid. For 
3” table appear at the bottom of the grid 

cells. On the screen, word uses dotted gridlines to 
to show where the text will appear in a cell. These 
cument. (If you don’t see the gridlines, choose 
f-cell marks, click the Show/Hide button on the 

 



 
Practical Performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

1 Be able to insert table 
using the toolbar, insert 
table command and 
change columns width 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Inserting a table  

(2) Changing column width  

   

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 



Product Assessment 
 

Assessment Product/Service Specifications 
Acceptable Need Adjustments Not Acceptable 

(1) Table Produced 

(2) Column width changed 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



KNOWLEDGE ASSESSMENT 
ORAL WRITTEN 

(1) Explain briefly the procedures to follow 
when insert a table 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 



Trade:   COMPUTER APPLICATIONS 

 
 
 
 
 
 
 
Level:   I 
 
 
 
 
 
 
Module:  2 WORD PROCESSING PROGRAMS 
 
 
Unit:   2.3 WORKING WITH TABLES AND COLUMNS  

 
 
Training and Leaning Element [TLE]: 2.3.3 CONVERTING EXISTING TEXT TO A  

TABLE AND TABLE TO TEXT  
 

 
 

 
 
 
 
 
 

 
  

 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



1 Preparation of Training 
 

 
Learning Objectives 

 
At the end of this element the trainees must be able to convert text 
to table and table to text. 
 
 
 
 

 
Duration 

 
30 min 
 
 
 
 

 
Range statements 

 
Computer and word processing software  
 
 
 
 

 
Training Materials 

 
NIL 
 
 
 

 
Instructional  aids 

 
Information sheet 
 

 
Reference Materials 

 
Microsoft Word 97 users guide 
 

 
Trainees preparation 

 
Be aware of the computer room regulations 
 
 
 
 
 
 
 



 
2.  Presentation of Training/teaching steps 
 

 
Explain and demonstrate how to invert text to table and vice versa 
 
 
 
Converting Text to a Table 
 
 
You can easily convert text separated by paragraph marks, commas, and tab characters to a table. 
When you select text and choose the Convert Text to Table command from the Table menu, Word 
automatically creates a table using one of these characters to separate text into different cells. If 
more than one character could be used to separate the text, Word displays a dialog box so that you 
can select the one you want Word to use. Sometimes, you may need to remove extra paragraph 
marks, commas and tab characters to get the table arrangement you want. 
 
 
 
1. Select the lines of text or the paragraphs you want  to convert to a table 
 
2. From the Table menu, choose Convert Text to Table (ALT,A,T) 
 
Word converts the selected text into a table. If Word cannot determine how to convert the text, it 
displays a dialog box listing different conversion options. 
 
 
3. If word displays the convert Text to table dialog box, select the conversion options you want, 

and then choose the OK button. 
 
 
If the resulting table is not what you want, choose Undo from the Edit menu before taking any 
other action. 
 
 
 
 
 
 
 
 
 
 
 



 
2. Presentation of Training/teaching steps 
 

 
Convert Text to Table Options 
When you choose the Convert text to Table command and Word cannot determine 
how to convert the text, it displays the following dialog box so that you can choose the 
most appropriate conversion option. 
 
 
To convert a table to regular text paragraphs 
If you decide to present information in the table in a different way, you can convert 
the table text to ordinary text paragraphs. You can separate the contents of cells with 
commas and tab characters, or convert the contents of each cell into one or more 
paragraphs. Paragraph conversion is the best choice if any of the cells have several 
paragraphs. 
 
 
 
1. Select the rows of the table that you want to convert to text paragraphs.  
 
 
2. From the Table menu, choose convert table to Text (ALT, A,T) 
 
 
3. Select a Separate text with option if you want to use one different from the one  
 
4. word proposes. 
 
 
5. Choose the OK button. 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
2 Information sheet (hand out) 
 
Converting Text to a Table 
You can easily convert text separated by paragraph marks, commas, and tab characters to a table. 
When you select text and choose the Convert Text to Table command from the Table menu, Word 
automatically creates a table using one of these characters to separate text into different cells. If 
more than one character could be used to separate the text, Word displays a dialog box so that you 
can select the one you want Word to use. Sometimes, you may need to remove extra paragraph 
marks, commas and tab characters to get the table arrangement you want. 
1. Select the lines of text or the paragraphs you want  to convert to a table 
2. From the Table menu, choose Convert Text to Table (ALT,A,T) 
Word converts the selected text into a table. If Word cannot determine how to convert the text, it 
displays a dialog box listing different conversion options. 
3. If word displays the convert Text to table dialog box, select the conversion options you want, 

and then choose the OK button. 
If the resulting table is not what you want, choose Undo from the Edit menu before taking any other 
action. 
Convert Text to Table Options 
When you choose the Convert text to Table command and Word cannot determine how to convert 
the text, it displays the following dialog box so that you can choose the most appropriate conversion 
option. 
To convert a table to regular text paragraphs 
If you decide to present information in the table in a different way, you can convert the table text to 
ordinary text paragraphs. You can separate the contents of cells with commas and tab characters, or 
convert the contents of each cell into one or more paragraphs. Paragraph conversion is the best 
choice if any of the cells have several paragraphs. 
1. Select the rows of the table that you want to convert to text paragraphs.  
2. From the Table menu, choose convert table to Text (ALT, A,T) 
3. Select a Separate text with option if you want to use one different from the one word proposes. 
4. Choose the OK button. 
 
 

 
 



Practical Performance Assessment 
Direct Performance 
 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

1 Be able to convert table 
to text and text to table 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Table changed to text 

(2) Text changed to table  

   

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 



Product Assessment 
 

Assessment Product/Service Specifications 
Acceptable Need Adjustments Not Acceptable 

(1) Text changed to table 

(2) Table changed to text 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 



KNOWLEDGE ASSESSMENT 
ORAL WRITTEN 

(1) Explain briefly the procedures for 
changing text to table and table to text 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Write down the steps to change text to 
table 

 
(2) Write down the steps to change table to 

text 

 
 
 
 
 
 
 



TRADE:  COMPUTER APPLICATIONS 

 
Level:   I 
 
 
 
 
 
 
 
 
 
Module: 02  WORD PROCESSING 
 
 
Unit:   2.3  WORD WITH TABLES AND COLUMNS 

Training and Leaning Element [TLE]: 2.3.4 CREATING MULTIPLE 
COLUMN LAYOUT 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



1. Preparation of Training 
 
 
 
Learning objective 

 
At the end of this element, trainees must be able to create multiple 
columns 
 

 
Duration 

 
30 min 
 

 
Range Statement 

 
Computer and word processing software 
 

 
Training Materials 

 
NIL 
 

 
Instructional AIDS 

 
Information sheet 
 

 
Reference Materials 

 
Microsoft Word 97 user’s guide 
 

 
Trainees preparation 

 
Be aware of the computer room regulations 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
2. Presentation of training/teaching steps 
 



 
 
Explain and demonstrate how to create multiple columns. 
 
To see the columns side by side on the screen choose page layout from the view menu 
before or after this procedure. 
 
(1) If the toolbar is not displayed choose toolbar from the view menu (ALT V,T) 
 
(2) Click in the section whose text you want to format. 
 
 
(3) On the toolbar, click the text columns button 
 
(4) Drag to the right to select the number of columns you want. 
 
 
 
When you release  a mouse button, word formats the section that contains the insertion 
point. 
 
(1) Select the text that you want to format in the multiple columns or position the insertion 

point where you want to change number of columns. 
 
(2) From the format menu, choose columns (ALT, T,D) 
 
 
(3) Type or select the number of columns you want. 
 
(4) In the Apply to box, select the amount of text you want to format. 
 
 
(5) Choose the OK button. 
 
 
 
 
 
 
 
 
 
 
 
3. Information sheet (hand out) 
 



 
 
 
STEPS 
(1) If the toolbar is not displayed, choose toolbar from the view menu (ALT V,T) 
(2) Click in the section whose text you want to format. 
(3) On the toolbar, click the text columns button 
(4) Drag to the right to select the number of columns you want. When you release  a mouse 

button, word formats the section that contains the insertion point. 
 
Another way 
(1) Select the text that you want to format in the multiple columns or position the insertion 

point where you want to change number of columns. 
(2) From the format menu, choose columns (ALT, T,D) 
(3) Type or select the number of columns you want. 
(4) In the Apply to box, select the amount of text you want to format. 
(5) Choose the OK button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Be able to create multiple 
columns 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
(1) Multiple columns are 

created 
 
 
 
 
 
 
 
 
 
 

 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 
Product Assessment 
 



Product Specifications Assessment 
 Acceptable Needs for the Adjustments Not Acceptable 
(1) Multiple column are 

created 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
 
 
 



KNOWLEDGE ASSESSMENT 
 
 
ORAL WRITTEN 
Explain the advantages of using multiple 
columns 

(1) What is the use of multiple columns? 
(2) Write down the steps to create multiple 

columns 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 



TRADE:  COMPUTER APPLICATIONS 

 
Level:   I 
 
 
Module: 02  WORD PROCESSING 
 
 
 
 
Unit:   2.3  WORD WITH TABLES AND COLUMNS 

 

 

Training and Leaning Element [TLE]: 2.3.5 CREATING AND EDITING 
TABLES 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



1. Preparation of Training 
 
 
 
 
Learning objective 

 
At the end of this element, trainees must be able to insert table, 
borders, shading and margin cells 
 

 
Duration 

 
30 min 
 

 
Range Statement 

 
 
 

 
Training Materials 

 
 
 

 
Instructional AIDS 

 
 
 

 
Reference Materials 

 
Word processing training manual 
 

 
Trainees preparation 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



2. Presentation of training/teaching steps 
 
 
 
 
Demonstrate and explain how to insert table, insert borders, shading and merging cells 
 
Steps 
To insert table 
(1) Open the table menu and select insert table. 
(2) Specify the number of columns and the number of rows you want for your table  
(3) Click OK 
 
To insert border 
(1) Highlight the cells where borders have to be inserted 
(2) Open the format menu and select borders and shading 
(3) Select borders 
(4) Select grid if you want the borders all around your table and inside 
 
 
To shade parts of the tables 
(1) Highlight the part of the table you want to shade 
(2) Open the FORMAT MENU and select BORDERS and SHADING 
(3) Select SHADING  and then select the suitable shading percentage you can also 

choose the preferred columns 
(4) At the end click OK.  
 
 
 
Merging cells on a table. 
(1) Highlight the part of the table you want to merge 
(2) Open the TABLE menu and select MERGE CELLS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



3. Information sheet (hand out) 
 
 
To insert table 
(1) Open the table menu and select insert table. 
(2) Specify the number of columns and the number of rows you want for your table  
(3) Click OK 
 
To insert border 
(1) Highlight the cells where borders have to be inserted 
(2) Open the format menu and select borders and shading 
(3) Select borders 
(4) Select grid if you want the borders all around your table and inside 
 
To shade parts of the tables 
(1) Highlight the part of the table you want to shade 
(2) Open the FORMAT MENU and select BORDERS and SHADING 
(3) Select SHADING  and then select the suitable shading percentage  
(4) At the end click OK.  
 
Merging cells on a table. 
(1) Highlight the part of the table you want to merge 
(2) Open the TABLE menu and select MERGE CELLS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Able to create and edit table 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.1 Creating table  
1.2 Shading cells 
1.3 Merging cells 
 
 
 
 
 
 
 
 
 
 

 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 



Product Assessment 
 

Product Specifications Assessment 
 Acceptable Needs for the Adjustments Not Acceptable 
(1) Table is created 
(2) Table is shaded 
(3) Cells are merged 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
 



 
 

KNOWLEDGE ASSESSMENT 
 
 
ORAL WRITTEN 
(1) Explain the steps to insert a table  
(2) Explain the steps to insert borders 
 

(1) Write down the steps to be followed in 
order to merge cells in a table. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 



Trade:   COMPUTER APPLICATIONS 

 
 
Level:   I 
 
 
 
 
 
 
 
 
Module:  2 WORD PROCESSING PROGRAMS 
 
 
Unit:   2.4 MAIL MERGE 

 
Training and Leaning Element [TLE]: 2.4.1  CREATING FORM LETTER 
USING MAIL MERGE  
 

 
 
 

 
 
 
 
 

 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



1 Preparation of Training 
 

  
Learning Objectives 

 
At the end of this element, trainees must be able to create form 
letter using mail merge 
 

 
Duration 

 
40 min 
 

 
Range statements 

 
Computer and its peripherals  
 

 
Training Materials 

 
NIL 
 

 
Instructional  aids 

 
Information sheet 
 

 
Reference Materials 

 
Microsoft Word 97 users guide 
 

 
Trainees preparation 

 
Be aware of the regulations of the computer room  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 



2 Presentation  of Training/teaching steps 
  
Demonstrate and explain how to create form letters using mail merge. The following are the 
steps to follow: 
 
(1) Open a tools menu and select MAIL MERGE 
 
(2) Click CREATE under main document 
 
 
(3) Select FORM LETTERS 
 
(4) Select ACTIVE WINDOW if you want the current document to be your main document 
 
 
(5) Click GET DATA under DATA SOURCE 
 
(6) Select CREATE DATA SOURCE 
 
 
(7) Specify the field names you want in your data source.(NB: the fieldnames will appear as 

Header rows in the list of your data) Click and REMOVE any field names that you do 
not want, type and ADD any field names that you want and are not provided in the list. 

 
(8) At the end click OK. 
 
(9) Give the data source a file name and SAVE it. 
 
(10) Click EDIT DATA SOURCE 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



2. Presentation of Training/teaching steps 
 
  
(11) Type in the data for the different copies, then OK 
 
(12) Microsoft word will then take you back to the main document. Type the main document text as 

normal and when it is typed, click on each of the point where data will differ from one copy to 
another. Click INSERT MERGE FIELD and then click the appropriate FIELD NAME from 
the list. 

 
(13) To view the merged data click the VIEW MERGED DATA button (ABC) 
 
(14) To view next record, click arrow or click Record and then select Next record 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



3 Information sheet (hand out) 
 
Mail merge is a feature used to print a number of copies of a letter (or any other document) 
which have more or less the same contents but differ in few details (may be names and 
addresses are different in each copy) in MAIL MERGE, there is only one document having the 
text which is the same for every copy. It is called THE MAIN DOCUMENT. The document 
that differ from one copy to another is called the DATA SOURCE. The MAIN DOCUMENT 
and the DATA SOURCE are each prepared and saved separately and then at the end they are 
merged into single file with several copies. 
 
The following are the steps to follow: 
 
(1) Open a tools menu and select MAIL MERGE 
(2) Click CREATE under main document 
(3) Select FORM LETTERS 
(4) Select ACTIVE WINDOW if you want the current document to be your main document 
(5) Click GET DATA under DATA SOURCE 
(6) Select CREATE DATA SOURCE 
(7) Specify the field names you want in your data source (NB: the fieldnames will appear as 

Header rows in the list of your data) Click and REMOVE any field names that you do not 
want, type and ADD any field names that you want and are not provided in the list. 

 

 
 
 
 
 
 



3. Information sheet (hand out) 
 
  
 
 
 
(8) At the end click OK. 
 
(9) Give the data source a file name and SAVE it. 
 
(10) Click EDIT DATA SOURCE 
 
(11) Type in the data for the different copies, then OK 
 
(12) Microsoft word will then take you back to the main document. Type the main document 

text as normal and when it is typed, click on each of the point where data will differ from one 
copy to another. Click INSERT MERGE FIELD and then click the appropriate FIELD 
NAME from the list. 

 
 
 
(13) To view the merged data click the     
         VIEW MERGED DATA button (ABC) 
 
(14) To view next record, click arrow  
           or click Record and then select Next  
           record 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 



Practical Performance Assessment 
Direct Performance 
 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

1 Be able to  create form 
letter using mail merge 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Main document created 

(2) Data source created 

(3) Fieldnames created according 
to instruction 

 
(4) Fieldnames not needed are 

removed 
 
(5) Main document and data 

source files are saved properly 
 
(6) Data source edited as required 

   

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 



Product Assessment 
 

Assessment Product/Service Specifications 
Acceptable Need Adjustments Not Acceptable 

(1) Main document created as 
required 

 
(2) Data source produced  

(3) Merge letters are printed 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



KNOWLEDGE ASSESSMENT 
 

ORAL WRITTEN 
(1) Explain what is mail merge 
 
(1) What do you understand by 

DATASOURCE 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A trainee should answer the following 
questions. 
 
(1) Why do we use mail merge? 
 
(2) Write down the icon representing 

VIEW MERGED DATA 
 
(3) Write down the steps to follow to mail 

merge a form letter  

 
 



TRADE:  COMPUTER APPLICATIONS 

 
 
Level:   I 
 
 
 
 
 
 
 
Module: 02  WORD PROCESSING 
 
 
Unit:   2.5 INSERT ITEMS 

Training and Leaning Element [TLE]: 2.5.1 INSERTING HEADER AND 
FOOTER 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



 
1. Preparation of Training 
 
 
 
Learning objective 

 
At the end of this training unit the trainee must be able to insert 
header and footer in the document 
 

 
Duration 

 
10 minutes 
 

 
Range Statement 

 
System unit, monitor keyboard, mouse and printer 
 

 
Training Materials 

 
NIL 
 

 
Instructional AIDS 

 
Handouts 
 

 
 
Reference Materials 

 
 
Word processing books 
 
 

 
 
Trainees 
preparation 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 



2.   Presentation of training/teaching steps 
 
 
 
 
 
Demonstrate and explain to the trainees how to insert the header and footer 
 
STEPS: 
(1) From the file menu, choose page setup the page setup dialogue box appears. 
(2) In the header and/ or Footer box, type the text you want to use as header or footer, 

along with any of the codes that can be used in these boxes. The header and footer 
boxes will scroll  as you type in the text 

(3) Choose the OK button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



3. Information sheet (hand out) 
 
 
 
 
(1) From the file menu, choose page setup the page setup dialogue box appears. 
 
(2) In the header and/ or Footer box, type the text you want to use as header or footer, along 

with any of the codes that can be used in these boxes. The header and footer boxes will 
scroll  as you type in the text 

 
(3) Choose the OK button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Able to insert header and 
footer 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Inserting footer 
(2) Inserting header 
 
 
 
 
 
 
 
 
 
 

 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 
 



Product Assessment 
 

Product Specifications Assessment 
 Acceptable Needs for the Adjustments Not Acceptable 
(1) Inserting header 
(2) Inserting footer 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



KNOWLEDGE ASSESSMENT 
 
 
ORAL WRITTEN 
(1) What is  header 
(2) What is a footer? 
(3) Explain the importance of inserting 

header and footer. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 



TRADE:  COMPUTER APPLICATIONS 

 
 
 
Level:   I 
 
 
 
 
Module: 02  WORD PROCESSING 
 
 
Unit:   2.5 INSERT ITEMS 

Training and Leaning Element [TLE]: 2.5.2 INSERTING DATE AND TIME 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 
 
 
 
 
 
 
 
 



1. Preparation of Training 
 
 
 
Learning objective 

 
At the end of this training element the trainee must be able to 
insert date and time  in the document 
 

 
Duration 

 
10 minutes 
 

 
Range Statement 

 
System unit, monitor keyboard, mouse and printer 
 

 
Training Materials 

 
NIL 
 

 
Instructional AIDS 

 
Handouts 
 

 
 
Reference Materials 

 
 
Word processing books 
 
 

 
 
Trainees 
preparation 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 



 
2.   Presentation of training/teaching steps 
 
 
Demonstrate and explain to the trainees how to insert date and time 
Steps 
(1) From the insert menu choose date and time the dialog box appears 
(2) In the date and time dialog box, select the date and time style you want  
(3) Choose the OK button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



2. Information sheet (hand out) 
 
 
 
(1) From the insert menu choose date and time the dialog box appears 
(2) In the date and time dialog box, select the date and time style you want  
(3) Choose the OK button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Able to insert date and time 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Insert date and time  
 
 
 
 
 
 
 
 
 
 

 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 
 



Product Assessment 
 

Product Specifications Assessment 
 Acceptable Needs for the Adjustments Not Acceptable 
(1) Insert date and time 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
 
 
 



 
KNOWLEDGE ASSESSMENT 

 
 
ORAL WRITTEN 
(1) What is  the importance of inserting 

date and time? 
  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 



TRADE:  COMPUTER APPLICATIONS 

 
 
 
 
 
LEVEL  1 
 
 
 
 
 
Module: 02  WORD PROCESSING 
 
 
Unit:   2.5 INSERT ITEMS 

Training and Leaning Element [TLE]: 2.5.3 INSERTING PAGE NUMBER 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 
 



 
1. Preparation of Training 
 
 
 
Learning objective 

 
At the end of this training element the trainee must be able to insert 
page numbers 
 

 
Duration 

 
10 minutes 
 

 
Range Statement 

 
A computer room with the required items: System unit, monitor 
keyboard and printer 
 

 
Training Materials 

 
NIL 
 

 
Instructional AIDS 

 
Handouts 
 

 
 
Reference 
Materials 

 
 
Word processing training manual 
 
 

 
 
Trainees 
preparation 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 



 
2.   Presentation of training/teaching steps 
 
 
Demonstrate and explain to the trainees how to insert page numbers 
 
Steps 
(1) From the insert menu, choose page numbers. The page number dialog box will appear 
 
(2) Click the format to select the style of the member you want 
 
(3) Click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
3. Information sheet (hand out) 
 
 
 
(1) From the insert menu choose page numbers. The page number dialog box will appear 
 
(2) Click the format to select the style of the member you want 
 
(3) Click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Able to insert page numbers 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Insert page numbers 
 
 
 
 
 
 
 
 
 

 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 



 
Product Assessment 
 

Product Specifications Assessment 
 Acceptable Needs for the Adjustments Not Acceptable 
(1) Insert page numbers 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 



 
 
 

KNOWLEDGE ASSESSMENT 
 
 
ORAL WRITTEN 
(1) Why do we need page numbers? 
  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 



TRADE:  COMPUTER APPLICATIONS 

 
 
 
LEVEL  1 
 
 
 
 
 
 
 
 
 
 
 
 
 
Module: 02  WORD PROCESSING 
 
 
Unit:   2.5 INSERT ITEMS 

Training and Leaning Element [TLE]: 2.5.4 INSERTING ENDNOTE AND  
                              FOOTNOTE 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



1. Preparation of Training 
 
 
 
 
Learning objective 

 
At the end of this training element the trainee must be able to 
insert endnote and footnote 
 
 
 

 
Duration 

 
10 minutes 
 
 
 

 
Range Statement 

 
 
 

 
Training Materials 

 
 
 
 
 

 
Instructional AIDS 

 
 
 
 
 

 
 
Reference Materials 

 
 
Word processing training manual 
 
 

 
 
Trainees 
preparation 
 
 

 
 
 
 
 
 
 
 

 
 
 



 
2.   Presentation of training/teaching steps 
 
 
Demonstrate and explain how to insert footnote and endnote  
 
Steps 
(1) Click next to the word you want to create the footnote or endnote (you must click exactly 

where you want the footnote number to appear) 
(2) Open the insert menu and select footnote or endnote 
(3) Click OK 
(4) Type the footnote or endnote text 
(5) Then scroll up the screen back to your document 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
3. Information sheet (hand out) 
 
 
 
 
(1) Click next to the word you want to create the footnote or endnote (you must click exactly 

where you want the footnote number to appear) 
(2) Open the insert menu and select footnote or endnote 
(3) Click OK 
(4) Type the footnote or endnote text 
(5) Scroll up the screen back to your document 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Able to insert endnote and 
footnote 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Insert footnote and endnote 
 
 
 
 
 
 
 
 
 

 
 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 
 
 



 
 
Product Assessment 
 

Product Specifications Assessment 
 Acceptable Needs for the Adjustments Not Acceptable 
(1) Insert footnote and 

endnote 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   



KNOWLEDGE ASSESSMENT 
 
 
ORAL WRITTEN 
(1) What are the uses of footnote and 

endnote 
  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



Trade: 1 COMPUTER APPLICATIONS 

 
 
 
 
 
 
 
Level:   I 
 
 
 
 
 
 
 
Module:      3       WORD PROCESSING PROGRAMS 
 
 
Unit:       3.2      MAIL MERGE 

 
 

 [TLE]:            3.2.1    CREATING FORM LETTER USING MAIL MERGE  
 

 
 
 
 

 
 
 
 
 

 
  

 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



 
Preparation of Training 
 
 

 
Learning Objectives 

 
At the end of this element, trainees must be able to create form 
letter using mail merge 
 

 
Duration 

 
40 min 
 

 
Range statements 

 
Computer and its peripherals  
 

 
Training Materials 

 
NIL 
 

 
Instructional  aids 

 
Information sheet 
 

 
Reference Materials 

 
Microsoft Word 97 users guide 
 

 
Trainees preparation 

 
Be aware of the regulations of the computer room  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Presentation of Training/teaching steps 
 
 
 
Demonstrate and explain how to create form letters using mail merge. The following are the 
steps to follow: 
 
(1) Open a tools menu and select MAIL MERGE 
 
 
(2) Click CREATE under main document 
 
 
(3) Select FORM LETTERS 
 
 
(4) Select ACTIVE WINDOW if you want the current document to be your main document 
 
 
(5) Click GET DATA under DATA SOURCE 
 
 
(6) Select CREATE DATA SOURCE 
 
 
(7) Specify the field names you want in your data source.(NB: the fieldnames will appear as 

Header rows in the list of your data) Click and REMOVE any field names that you do not 
want, type and ADD any field names that you want and are not provided in the list. 

 
 
(8) At the end click OK. 
 
 
(9) Give the data source a file name and SAVE it. 
 
(10) Click EDIT DATA SOURCE 
 
 
 



 
Presentation of Training/teaching steps 
 
(11) Type in the data for the different copies, then OK 
 
 
 
 
(12) Microsoft word will then take you back to the main document. Type the main document text 

as normal and when it is typed, click on each of the point where data will differ from one copy 
to another. Click INSERT MERGE FIELD and then click the appropriate FIELD NAME from 
the list. 

 
(13) To view the merged data click the VIEW MERGED DATA button (ABC) 
 
(14) To view next record, click arrow or click Record and then select Next record 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Information sheet (hand out) 
 
 
 
 
 
 
Mail merge is a feature used to print a number of copies of a letter (or any other document) 
which have more or less the same contents but differ in few details (may be names and 
addresses are different in each copy) in MAIL MERGE, there is only one document having the 
text which is the same for every copy. It is called THE MAIN DOCUMENT. The document 
that differ from one copy to another is called the DATA SOURCE. The MAIN DOCUMENT 
and the DATA SOURCE are each prepared and saved separately and then at the end they are 
merged into single file with several copies. 
 
The following are the steps to follow: 
 
(1) Open a tools menu and select MAIL MERGE 
 
 
(2) Click CREATE under main document 
 
 
(3) Select FORM LETTERS 
 
 
(4) Select ACTIVE WINDOW if you want the current document to be your main document 
 
 
(5) Click GET DATA under DATA SOURCE 
 
 
(6) Select CREATE DATA SOURCE 
 
 
(7) Specify the field names you want in your data source (NB: the fieldnames will appear as 

Header rows in the list of your data) Click and REMOVE any field names that you do not 
want, type and ADD any field names that you want and are not provided in the list. 

 
 
 
 
 
 



 
3. Information sheet (hand out) 

 
 
 
(8) At the end click OK. 
 
 
(9) Give the data source a file name and SAVE it. 
 
 
(10) Click EDIT DATA SOURCE 
 
 
(11) Type in the data for the different copies, then OK 
 
 
(12) Microsoft word will then take you back to the main document. Type the main 

document text as normal and when it is typed, click on each of the point where data 
will differ from one copy to another. Click INSERT MERGE FIELD and then click 
the appropriate FIELD NAME from the list. 

 
 
(13) To view the merged data click the     
         VIEW MERGED DATA button (ABC) 
 
 
(14) To view next record, click arrow  
           or click Record and then select Next  
           record 
 
 
 
 
 
 
 
 

 
 



 
Practical Performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

1 Be able to  create form 
letter using mail merge 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Main document created 

(2) Data source created 

(3) Fieldnames created according 
to instruction 

 
(4) Fieldnames not needed are 

removed 
 
(5) Main document and data 

source files are saved properly 
 
(6) Data source edited as required 

   

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 



Product Assessment 
Assessment Product/Service Specifications 

Acceptable Need Adjustments Not Acceptable 
(1) Main document created as 

required 
 
(2) Data source produced  

(3) Merge letters are printed 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 



KNOWLEDGE ASSESSMENT 
ORAL WRITTEN 

(1) Explain what is mail merge 
 
(1) What do you understand by 

DATASOURCE 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A trainee should answer the following 
questions. 
 
(1) Why do we use mail merge? 
 
(2) Write down the icon representing 

VIEW MERGED DATA 
 
(3) Write down the steps to follow to mail 

merge a form letter  

 
 
 



TRADE:  COMPUTER APPLICATIONS 

 
 
 
LEVEL  1 
 
 
 
 
Module: 03  SPREADSHEET 
 
 
 
Unit:   3.2 WORKING WITH WORKSHEETS 

 

 

 [TLE]:           3.2.3 TO CREATE AND SAVING A (FILE) SPREADSHEET 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
1. Preparation of Training 
 
 
Learning objective 

 
At the end of this element,  trainee must be able to create and save 
the spreadsheet 
 

 
Duration 

 
10 minutes 
 

 
Range Statement 

 
Computer with Excel installed 
 

 
Training Materials 

 
NIL 
 

 
Instructional AIDS 

 
Information sheet 
 

 
 
Reference Materials 

 
 
Excel 97- Step by step book  
 
 

 
 
Trainees 
preparation 
 
 

 
 
Computer room regulations awareness 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 



2.   Presentation of training/teaching steps 
 
Demonstrate and explain the process of saving a document 
 
Steps  
 
(To save) 
(1) Open a file menu and select SAVE AS 
(2) Ms Excel will take you to a dialog box. Type the filename and select the folder you want to 

save your file in. 
(3) Click SAVE 

 
NB: Save As is useful when you want to change the name of the file 
 
To create  
(1) Open File menu 
(2) Select New 
(3) Click on OK button 

 
 



3. Information sheet (hand out) 
 
 
Steps 
(Saving) 
(1)  Open a file menu and select SAVE AS 
(4) Ms Excel will take you to a dialog box. Type the filename and select the folder you want 

to save your file in. 
(5) Click SAVE 
 
NB: Save As is useful when you want to change the name of the file 
 
To create  
(1) Open File menu 
(2) Select New 
(3) Click on OK button 
 
 

 
 
 



Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 The file is created and saved 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.1 The file is saved 
1.2 The file is created 
 
 
 
 
 
 
 
 
 
 

 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 



 
Product Assessment 
 

Product Specifications Assessment 
 Acceptable Needs for the Adjustments Not Acceptable 
(1) Created a file 
(2) Saved file 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 



 
KNOWLEDGE ASSESSMENT 
ORAL WRITTEN 
Write down the procedures for saving a file 
Explain the steps to create a new spreads 
sheet 
 
  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



TRADE:  COMPUTER APPLICATIONS 

 
 
 
 
LEVEL  1 
 
 
 
 
Module: 3.2 SPREADSHEET 
 
Unit:   

Training and Leaning Element [TLE]: 3.2.4 SUMMARIZING DATA WITH 
SUBTOTALS  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 

 
 



 
Preparation of Training 
 
 
 
Learning objective 

 
At the end of this element,  trainee must be able summarize data 
with subtotals. 
 

 
Duration 

 
30 minutes 
 

 
Range Statement 

 
Computer with spreadsheet boarded 
 

 
Training Materials 

 
NIL 
 

 
Instructional AIDS 

 
Information sheet 
 

 
 
Reference Materials 

 
 
(Excel book ) Spreadsheet books 
 
 

 
 
Trainees 
preparation 
 
 

 
 
Aware of computer room regulations  
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 



 
2.   Presentation of training/teaching steps 
 
 
 
Demonstrate and explain how to summarize data with subtotals 
 
Steps  
(1) Select any cell within the inventory list 
 
(2) On data menu click subtotal (The subtotal dialog appears) 
 
(3) Click the At Each Change in down arrow and then click source country. 
 
(4) Click the use function down arrow, and then click Sum 
 
(5) In the Add subtotal to box, select the value check box and then scroll through the list 

to be sure that all the other check boxes are cleared  
 
(6) Be sure that the Replace current subtotals and summary below Data check boxes are 

selected 
 
(7) Click OK 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
3. Information sheet (hand out) 
 
 
(1) Select any cell within the inventory list 
 
(2) On data menu click subtotal (The subtotal dialog appears) 
 
(3) Click the At Each Change in down arrow and then click source country. 
 
(4) Click the use function down arrow, and then click Sum 
 
(5) In the Add subtotal to box, select the value check box and then scroll through 

the list to be sure that all the other check boxes are cleared  
 
(6) Be sure that the Replace current subtotals and summary below Data check 

boxes are selected 
 
(7) Click OK 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Able to summarize data with 
subtotals 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.1 Inventory list selected 
 
1.2 Subtotal is selected 
 
1.3 The summary is displayed 
 
 
 
 
 
 
 
 
 
 

 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 



 
Product Assessment 
 

Product Specifications Assessment 
 Acceptable Needs for the Adjustments Not Acceptable 
The summarize with 
subtotals is done 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 



 
 
 

KNOWLEDGE ASSESSMENT 
 
 
ORAL WRITTEN 
(1) What is the importance of summarizing 

data? 
 
 
  
 
 

(1) Write down the steps to summarize 
data with subtotals 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 



TRADE:  COMPUTER APPLICATIONS 

 
 
 
 
LEVEL  1 
 
 
 
 
Module: 3 SPREADSHEET 
 
 
Unit:   3.2 FORMAT DATA AND PERFORM BASIC CALCULATIONS  

Training and Leaning Element [TLE]: 3.2.5 INSERT AND DELETE 
ROWS/COLUMNS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 

 



1. Preparation of Training 
 
 
 
Learning objective 

 
At the end of this element, trainee must be able to insert and delete 
rows/columns 
 

 
Duration 

 
10 minutes 
 

 
Range Statement 

 
Computer with spreadsheet application 
 

 
Training Materials 

 
NIL 
 

 
Instructional AIDS 

 
Information sheet 
 

 
 
Reference Materials 

 
 
Excel training manual 
 
 

 
 
Trainees 
preparation 
 
 

 
 
Be aware of computer room regulations  
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 



2.   Presentation of training/teaching steps 
 
 
 
 
 
 
Demonstrate and explain the steps to insert and delete rows/columns  
 
Steps 
(Insert) 
(1) To insert a row/column click the row/column heading below where you want to insert 
 
(2) From the Edit menu, choose insert 
 
 
(3) Click rows/columns 
 
To delete 
(1) To delete row/column click the row/column heading you want to delete 
 
(2) From the edit menu choose delete (ALT, E,D)  
 
 
(3) Select Entire row/column  
 
(4) Press Enter or OK 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



3. Information sheet (hand out) 
 
 
 
 
To insert a row/column  
 
(1) Click the row/column heading below where you want to insert 
 
(2) From the Edit menu, choose insert 
 
(3) Click rows/columns 
 
To delete 
(1) To delete row/column click the row/column heading you want to delete 
 
(2) From the edit menu choose delete (ALT, E,D)  
 
(3) Select Entire row/column  
 
(4) Press Enter or OK 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Able to Insert and delete row 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.1 Insert column 
1.2 Insert row 
1.3 Delete row 
1.4 Delete column 

 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 



Product Assessment 
 

Product Specifications Assessment 
 Acceptable Needs for the Adjustments Not Acceptable 
1.   Column Inserted 
2. Row Inserted 
3. Row deleted 
4. Column deleted 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 



 
 
 

KNOWLEDGE ASSESSMENT 
 
 
ORAL WRITTEN 
(1) Explain the steps for inserting and 

deleting a row/column 
 
 
 
  
 
 

(1) Give the reason for deleting a 
row/column 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



TRADE:  COMPUTER APPLICATIONS 

 
 
 
LEVEL  1 
 
 
 
 
 
 
 
Module: 03 SPREADSHEET 
 
 
Unit:   3.3 FORMAT DATA AND PERFORM BASIC CALCULATIONS  

 [TLE]: 3.3.1 USING AUTO AND ADVANCED FILTER 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



Preparation of Training 
 
 
 
 
Learning objective 

 
At the end of this element, the trainee must be able to use Auto and 
advanced filters 
 

 
Duration 

 
30 minutes 
 

 
Range Statement 

 
Computer with excel program installed 
 

 
Training Materials 

 
NIL 
 

 
Instructional AIDS 

 
Information sheet 
 

 
 
Reference Materials 

 
 
Excel book- step by step 
 
 

 
 
Trainees 
preparation 
 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 



 
2.   Presentation of training/teaching steps 
 
 
 
Demonstrate and explain the procedure of using Auto and advanced filters 
 
Steps 
 
(1) Select the data you want to filter 
 
(2) Open the data menu  
 
 
(3) Select Filter 
 
(4) Under filter submenu, select auto filter. Once you click on auto filter, arrows will 

display next to every heading which are used for filtering data 
 
 
(5) To filter any one column click on the row for that particular column 
 
(6) Select custom 
 
 
(7) Type the criteria required 
 
(8) Click on OK button 
 
 
 
 
 



 
3. Information sheet (hand out) 
 
 
 
 
(1) Select the data you want to filter 
 
(2) Open the data menu  
 
(3) Select Filter 
 
(4) Under filter submenu, select Auto filter. Once you click on auto filter, arrows will display 

next to every heading which are used for filtering data 
 
(5) To filter any one column click on the row for that particular column 
 
 
(6) Select custom 
 
 
 
(7) Type the criteria required 
 
 
 
 
(8) Click on OK button 
 
 
 
 
 
 
 
 



 
 
Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 1.0 Data  filtered using Auto 
and advanced filters 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Data filtered using Auto 
filter 

 
(2) Data filtered using 

advanced filter 
 

 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 



Product Assessment 
 

Product Specifications Assessment 
 Accept

able 
Needs for the Adjustments Not Acceptable 

1.1 Data filtered using 
Auto filter 

 
1.2 Data filtered using 

advanced filter 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   



KNOWLEDGE ASSESSMENT 
 
ORAL WRITTEN 
(1) Explain the steps to filters data using 

advanced filter 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 



TRADE:  COMPUTER APPLICATIONS 

 
 
 
 
LEVEL  1 
 
 
 
Module: 03 SPREADSHEET 
 
 
Unit:   3.5 NAME WORKING RANGES AND USE ABSOLUTE CELL  

    REFERENCES 

Training and Leaning Element [TLE]: 3.5.1 COPY AND PASTE RANGES 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



 
1. Preparation of Training 
 
 
 
 
Learning objective 

 
At the end of this element, the trainee must be able to copy and 
paste cell range 
 

 
Duration 

 
10 minutes 
 

 
Range Statement 

 
Computer with excel program loaded installed 
 

 
Training Materials 

 
NIL 
 

 
Instructional AIDS 

 
Information sheet 
 

 
 
Reference Materials 

 
 
Excel training manual 
Ms excel –step by step book 
 
 

 
 
Trainees 
preparation 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 



2.   Presentation of training/teaching steps 
 
 
Demonstrate and explain the steps to copy and paste the cell ranges 
 
Steps 
(Copy) 
(1) Select or define all the cell containing Data or objects 
 
(2) Open Edit menu 
 
(3) Select Copy from the menu 
 
(4) Move your cell/click where you want the data to start appearing  
 
(5) Open Edit menu again 
 
(6) Select Paste 
 
 

 
 
 
 
 
 
 
 



3. Information sheet (hand out) 
 
 
(1) Select or define all the cell containing Data or objects 
 
(2) Open Edit menu 
 
(3) Select Copy from the menu 
 
(4) Move your cell/click where you want the data to start appearing  
 
(5) Open Edit menu again 
 
(6) Select Paste 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 



 
Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Copy and paste cell ranges 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.1 Cell ranges copied 
1.2 Cell ranges pasted 
 

 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 



Product Assessment 
 

Product Specifications Assessment 
 Accept

able 
Needs for the Adjustments Not Acceptable 

1.1 Copied cell ranges  
 
1.2 Cell ranges pasted 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
 



KNOWLEDGE ASSESSMENT 
 
 
ORAL WRITTEN 
 
 
 
 
 
  
 
 

 
(1) Explain the steps to copy the cell 

ranges 
 
(2) Explain the steps to paste cell ranges 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 



TRADE:  COMPUTER APPLICATIONS 

 
 
 
 
LEVEL  1 
 
 
 
 
Module: 03 COMPUTER AWARENESS, OPERATION AND    
TROUBLESHOOTING 
 
 
 
 
Unit:   3.5 COMPUTER BASICS, HARDWARE AND SOFTWARE 

 

 

 [TLE]:         3.5.2 IDENTIFY AND CONNECT COMPUTER DEVICES 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



 
1. Preparation of Training 
 
 
Learning objective 

 
At the end of this element, the trainee must be able to  
- Identify computer devices 
- Connect computer devices 
 

 
Duration 

 
1 Hours 
 

 
Equipment/tools 

 
System unit, monitor, keyboard, mouse and printer 
 

 
Training Materials 

 
NIL 
 

 
Teaching AIDS 

 
Handouts 
 

 
 
Reference Materials 

 
 
 
 
 

 
 
Trainees 
preparation 
 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 



 
2.   Presentation of training/teaching steps 
 
 

Demonstrate and explain to trainees how to identify ports and collect/prepare all devices to be 
connected to the system unit 
 
STEPS 
1. Explain the use of each device and identify the ports to connect the devices 
  
2. Connect each devices to the computer system unit. 
 
3. Re-check the cables connections. 
 
4. Connect the power supply cable to the wall socket outlet. 
 
 

 
 



 
3. Information sheet (hand out) 
 
1. Identify the ports to connect the devices 
2. Connect each devices to the respective port on the  computer system unit. 
3. Re-check the cables connections. 
4. Connect the power supply cable to the wall socket outlet and put it on. 
5. Put on the system unit and the monitor to check if your correct 
NB: If the connection is not correct the computer will display error message. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ref    Component   Function 
 
1. Power Cord Connection  Connects the computer to an electrical power outlet 
  
2. Microphone connector  Connects a microphone for recording sound and voice 
 
3. Line-In audio Connector Connects an external audio output device. Such as speakers or a 

cassette tape recorder.  
 
4. Line-Out Audio Connector  Connects an audio in put device 
 
5. Headphone Connector  Connects headphones 
 
6. Voltage Select Switch Switches voltage between 115 V (U.S) and 230 V to match 

geographical requirements. 
 
7. Serial Connector  Connects  a serial device. Such as serial printer 
  
8. Parallel Connector  Connects a parallel device, such as parallel printer 
 
9. Keyboard connector  Connects the keyboard 
 
10. Mouse connector  Connects the mouse 
 
11. Universal Serial Bus Connector Connects in the computer to any peripheral while the computer is  

operating. Is a fully functional plug and play connector 
 
12. Monitor Connector  Connects a monitor to an embedded graphics controller 

 
 



 
Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Able to identify computer 
devices and connect them 
accordingly 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.1 Identify devices as per 
range statement 

1.2 Identify correct ports for 
connecting peripheral 
devices to the system unit 

 
 

 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 



Product Assessment 
 

Product Specifications Assessment 
 Accept

able 
Needs for the Adjustments Not Acceptable 

After connecting all the 
devices to the correct ports 
then,  the system will not give 
any error message. Error 
alarm or a message No signal 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   



 
KNOWLEDGE ASSESSMENT 
 
ORAL WRITTEN 
1. What is a port? 
 
2. Why are we connecting other devices 

(Peripheral devices) to the main unit? 
 
3. What is the difference between parallel 

and serial ports? 
 
4. List down the three components of the 

computer system 
 
5. What will happen if a keyboard is not 

going to be connected to the system 
unit. 

 
 
 
  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 



TRADE:  COMPUTER APPLICATIONS 

 
 
 
 
LEVEL  1 
 
 
 
 
Module: 05 ELECTRONIC MAIL 
 
 
Unit:   5.1 SEND AND RECEIVE E-MAIL 

Training and Leaning Element [TLE]: 5.1.1 CREATING AND SENDING E-
MAIL MESSAGE 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 

 
 
 



 
 
1. Preparation of Training 
 
 
 
 
 
Learning objective 

 
At the end of this element, the trainee must be able to  create and 
send E-mail messages 
 

 
Duration 

 
30 minutes 
 

 
Equipment/tools 

 
Computer connected to the internet 
 

 
Training Materials 

 
NIL 
 

 
Teaching AIDS 

 
Information sheet 
 

 
 
Reference Materials 

 
 
Word processing training manual 
 
 

 
 
Trainees 
preparation 
 
 

 
 
Be aware of computer room regulations 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 



2. Presentation of training/teaching steps 
 
 

1. Click the compose button or from the mail menu, choose compose 
2. Choose address button 
3. Type the first few characters of your name 
4. Press enter or choose To button. Your user name is added to the To box 
5. Press enter or choose OK button. 

 
 

 
 

 
 
 



3. Information sheet (hand out) 
 
 
Demonstrate and explain the process of sending E-mail message. 
 
Steps 
1. Click the compose button or from the mail menu, choose compose 
 
2. Choose address button 
 
3. Type the first few characters of your name 
 
4. Press enter or choose To button. Your user name is added to the To box 
5. Press enter or choose OK button. 
 

 

 
 



 
 
Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Able to send E-mail messages 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(1) Compose button is 
selected 

(2)  Address is inserted 
 
 
 

 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 
 
 



Product Assessment 
 

Product Specifications Assessment 
 Acceptable Needs for the Adjustments Not Acceptable 
1.1 Select compose button 

by click 
1.2 Insert the recipient 

address 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
 



 
 

KNOWLEDGE ASSESSMENT 
 
 
ORAL WRITTEN 
 
 
 
 
  
 
 

 
(1) Write down the steps involve in 

sending E-mail 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 



TRADE:  COMPUTER APPLICATIONS 

 
 
 
 
LEVEL  1 
 
 
 
 
 
 
 
Module: 05 ELECTRONIC MAIL 
 
 
Unit:   5.1 SEND AND RECEIVE E-MAIL 

Training and Leaning Element [TLE]: 5.1.2 SENDING A MESSAGE 
IMMEDIATELY, LATER  

OR AT A CERTAIN TIME 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 

 
 



1. Preparation of Training 
 
 
 
 
Learning objective 

 
At the end of this element, trainee must be able to  send  message 
immediately, later or at a certain time. 
 

 
Duration 

 
30 minutes 
 

 
Equipment/tools 

 
Computer connected to the internet 
 

 
Training Materials 

 
NIL 
 

 
Teaching AIDS 

 
Information sheet 
 

 
 
Reference Materials 

 
 
Word processing training manual 
 
 

 
 
Trainees 
preparation 
 
 

 
 
 
Computer regulations awareness  
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 



 
2.   Presentation of training/teaching steps 
 
 

 
 
Demonstrate and explain the process of sending messages immediately later or at a 
certain time. 
 
Steps: 
 
(Immediately) 
(1) Click on the send button or select send immediately from the message menu. A 

progress window is displayed to show the progress of the transmission. 
 
Send later 
(1) Click on the queue button or select queue message from the message menu. The 

message window is closed, and the message is saved in the out  mailbox marked Q  
 
 
 
 
Sending at a certain time 
(1) Select a message then select change 
      queuing from the message menu. 
      The changing queuing dialog is 
      Displayed 
 
(2) If you choose right Now, the message is sent immediately when you click OK. If you 

choose Next time queued in the out mailbox with a Q in the status column and sent 
the next time queued messages are sent. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



3. Information sheet (hand out) 
 
 
 
 
 
 
Immediately 
(1) Click on the send button or select send immediately from the message menu. A progress 

window is displayed to show the progress of the transmission. 
 
Send later 
(1) Click on the queue button or select queue message from the message menu. The message 

window is closed, and the message is saved in the out  mailbox marked Q  
 
Sending at a certain time 
(1) Select a message then select change queuing from the message menu. The changing 

queuing dialog is Displayed 
 
(2) If you choose right Now, the message is sent immediately when you click OK. If you 

choose Next time queued in the out mailbox with a Q in the status column and sent the 
next time queued messages are sent. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Able to send messages 
Immediately, later or at a 
certain time 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.1 Sending message 
immediately 

 
1.2 Sending message later 
 
1.3 Sending message at a 

certain time. 
 
 
 

 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 



 
 
Product Assessment 
 

Product Specifications Assessment 
 Accept

able 
Needs for the Adjustments Not Acceptable 

(1) Messages are sent 
immediately 

 
(2) Messages are sent later 
 
(3) Messages are sent at a 

certain time 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 



 
 
 

KNOWLEDGE ASSESSMENT 
 
 
ORAL WRITTEN 
 
(1) How do you send the message 

immediately? 
 
 
 
  
 
 

 
(1) Write down the steps to be followed to 

send a message at a certain time. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 



TRADE:  COMPUTER APPLICATIONS 

 
 
 
 
 
 
 
LEVEL  1 
 
 
 
 
Module: 05 ELECTRONIC MAIL 
 
 
Unit:   5.1 SEND AND RECEIVE E-MAIL 

Training and Leaning Element [TLE]: 5.1.3 SETTING THE MESSAGE 
PRIORITY  

AND SAVING A MESSAGE 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 

 
 



1. Preparation of Training 
 
 
 
Learning objective 

 
At the end of this element, trainee must be able to  set message 
priority and saving a message 
 

 
Duration 

 
30 minutes 
 

 
Equipment/tools 

 
Computer connected to the internet 
 

 
Training Materials 

 
NIL 
 

 
Teaching AIDS 

 
Information sheet 
 

 
 
Reference Materials 

 
 
Word processing training manual 
 
 

 
 
Trainees 
preparation 
 
 

 
 
 
Be aware of the computer room regulations  
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 



2.   Presentation of training/teaching steps 
 
 

Demonstrate and explain the steps to follow to set the message priority and saving a message 
 
Steps: 
 
(Message priority) 
(1) To change the priority of the current message, use priority pop up 
 
Saving a message 
 
(1) To save the current message, select SAVE from the file menu. 
(2) To save all of the messages that you have opened, hold down the CTRL key and select save 

from the file menu 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



3. Information sheet (hand out) 
 
 
 
(Message priority) 
 
(1) To change the priority of the current message, use priority pop up 
 
Saving a message 
 
(1) To save the current message, select SAVE from the file menu. 
 
(2) To save all of the messages that you have opened, hold down the CTRL key and select 

save from the file menu 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Able to set message priority 
and saving 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.1 Message prioriting set 
 
1.2 Message saved 
 
 
 

 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 
 
 
 



Product Assessment 
 

Product Specifications Assessment 
 Accept

able 
Needs for the Adjustments Not Acceptable 

(1) Priority set 
 
(2) Message saved 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
 
 
 



 
KNOWLEDGE ASSESSMENT 

 
 
ORAL WRITTEN 
 
(1) Write down the reason for setting 

priority. 
 
(2) Write the steps to save the message in 

your floppy diskette 
 
  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 



TRADE:  COMPUTER APPLICATIONS 

 
 
 
 
 
LEVEL  1 
 
 
 
Module: 05 ELECTRONIC MAIL 
 
 
Unit:   5.1 SEND AND RECEIVE E-MAIL 

Training and Leaning Element [TLE]: 5.1.4 USING THE QUICK RECIPIENT 
LIST AND  

ATTACHING A FILE TO A MESSAGE 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



 
1. Preparation of Training 
 
 
 
 
Learning objective 

 
At the end of this element, the trainee must be able to  use 
recipient list and attaching a file to a message 
 

 
Duration 

 
30 minutes 
 

 
Equipment/tools 

 
Computer connected to the internet 
 

 
Training Materials 

 
NIL 
 

 
Teaching AIDS 

 
Information sheet 
 

 
 
Reference Materials 

 
 
Word processing training manual 
 
 

 
 
Trainees 
preparation 
 
 

 
 
Computer room regulations awareness 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 



 
 
2.   Presentation of training/teaching steps 
 
 

 
 
Demonstrate and explain how to use quick recipient list and attaching a file to message 
 
Steps: 
 
(Use quick recipient list) 
(1) Select New message to, forward to or Redirect to from the message menu, and select the 

nickname form the displayed list. 
 
(2) To insert a nickname into a message that you have already opened, put the cursor where you 

want the nickname and select insert recipient from the edit menu. 
 
 
(3) To insert a real address(es) instead of nickname, hold down the shift key and select insert 

recipient from the edit menu. 
 
 
 
Attaching a file to a message 
(1) Select Attach file (to new) from the message menu. The attach file dialog is displayed 
 
(2) Find the file you want select it and click on the attach button to attach the document to the 

current message or open a new message with the file attached to it. The name of the 
document is displayed automatically in the attachments field 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
3. Information sheet (hand out) 
 
 
 
 
(1) Select New message to, forward to or Redirect to from the message menu, and select the 

nickname form the displayed list. 
 
(2) To insert a nickname into a message that you have already opened, put the cursor where 

you want the nickname and select insert recipient from the edit menu. 
 
(3) To insert a real address(es) instead of nickname, hold down the shift key and select insert 

recipient from the edit menu. 
 
 
 
Attaching a file to a message 
(1) Select Attach file (to new) from the message menu. The attach file dialog is displayed 
Find the file you want select it and click on the attach button to attach the document to the 
current message or open a new message with the file attached to it. The name of the 
document is displayed automatically in the attachments field 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Able to use quick recipient list 
and attaching a file to message. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1.1 Quick recipient list is used 
 
1.2 File is attached to the 

message 
 
 
 

 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 
 
 



 
Product Assessment 
 

Product Specifications Assessment 
 Acceptable Needs for the 

Adjustments 
Not Acceptable 

(1) Use  of quick recipient 
list  

(2) The file is attached to 
the message 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
 
 



 
KNOWLEDGE ASSESSMENT 

 
 
ORAL WRITTEN 
 
(1) What is the recipient list 
  
 
 

 
(1) Explain the process of attaching a file 

to a message. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 



TRADE:  COMPUTER APPLICATIONS 

 
 
 
LEVEL  1 
 
 
 
 
Module: 05 ELECTRONIC MAIL 
 
 
Unit:   5.1 SEND AND RECEIVE E-MAIL 

Training and Leaning Element [TLE]: 5.1.5 REDIRECTING A MESSAGE AND  
     SENDING  
      REPEATED MESSAGES AGAIN 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



 
1. Preparation of Training 
 
 
 
 
Learning objective 

 
At the end of this element, the trainee must be able redirect and 
sending rejected messages 
 

 
Duration 

 
30 minutes 
 

 
Equipment/tools 

 
Computer connected to the internet 
 

 
Training Materials 

 
NIL 
 

 
Teaching AIDS 

 
Information sheet 
 

 
 
Reference Materials 

 
 
Word processing training manual 
 
 

 
 
Trainees 
preparation 
 
 

 
 
Be aware of computer room regulations  
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 



 
2.   Presentation of training/teaching steps 
 
 

 
 
 
 
Demonstrate and explain the steps of redirecting and sending rejected messages again 
 
Steps: 
 
(Redirecting messages)  
(1) Select Redirect from the message menu. A new message window is displayed with the 

original sender’s address in the from field with the statement by way of your address 
“The original sender’s text in the message body, and the original attachments in the 
attachments field. 

 
(Sending rejected message) 
(1) Select Send again from the message menu. This  eliminates the inserted extra text and 

reformats the message as it originally appeared. You can then make changes or 
additions and send the message again. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
3. Information sheet (hand out) 
 
 
 
(1) Select Redirect from the message menu. A new message window is displayed with the 

original sender’s address in the from field with the statement by way of your address 
“The original sender’s text in the message body, and the original attachments in the 
attachments field. 

 
(Sending rejected message) 
(1) Select Send again from the message menu. This  eliminates the inserted extra text and 

reformats the message as it originally appeared. You can then make changes or 
additions and send the message again. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 
 



 
 
Product Assessment 
 

Product Specifications Assessment 
 Acceptable Needs for the 

Adjustments 
Not Acceptable 

(1) Message is redirected 
 
(2) Repeated message is 

sent again 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
 



 
 

KNOWLEDGE ASSESSMENT 
 
 
ORAL WRITTEN 
 
Why do we need to messages? 
  
 
 

 
Explain the steps to redirect and sending 
repeated messages again 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



TRADE:  COMPUTER APPLICATIONS 

 
 
 
LEVEL  1 
 
 
 
 
 
 
 
 
Module: 05 ELECTRONIC MAIL 
 
 
Unit:   5.1 SEND AND RECEIVE E-MAIL 

 [TLE]:            5.1.6 READING AND DELETING THE MESSAGE 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



 
1. Preparation of Training 
 
 
Learning objective 

 
At the end of this element, the trainee must be able to read and 
delete E-mail messages 
 

 
Duration 

 
30 minutes 
 

 
Equipment/tools 

 
Computer connected to the internet 
 

 
Training Materials 

 
NIL 
 

 
Teaching AIDS 

 
Information sheet 
 

 
 
Reference Materials 

 
 
- Internet and email books 
- Microsoft mail- User’s guide 
 
 

 
 
Trainees 
preparation 
 
 

 
  
 
 
 

 
 
 
 
 
 
 
 
 



 
2.   Presentation of training/teaching steps 
 
 

 
 
Demonstrate and explain how to read and delete e-mail messages 
 
Steps: 
 
(Reading)  
(1) In the message header click Inbox to display the message. Mail displays a closed- envelope 

symbol and shows the sender’s name in bold. 
(2) Double click the message or press TAB to move the highlight from the Folders list to 

message list. 
(3) Press Enter. The message appears in read note form  
 
 
 
 
 (Deleting message) 
To manage the number of messages you keep in your Inbox, you should delete messages 
you’ve already read and no longer need. 
 
To delete a message from the Inbox 
1. In the Inbox, select the second Test Message. To  select Test Message, click it, or press 

TAB to move the highlight to the message list, use the ARROW KEYS to highlight it, and 
then press ENTER. 

 
 
 
2. Click the Delete button, or from the File menu, choose Delete (ALT, F,D). 
The message moves to the Wastebasket, where you can retrieve it until it is deleted there. The 
default Mail setting deletes messages in the Wastebasket when you quit Mail. To change this 
option, choose Options from the Mail menu. 
 
 
 
 
 
 
 
 
 
 
 



3. Information sheet (hand out) 
 
Steps: 
 
(Reading)  
(1) In the message header click Inbox to display the message. Mail displays a closed- envelope 

symbol and shows the sender’s name in bold. 
(2) Double click the message or press TAB to move the highlight from the Folders list to 

message list. 
(3) Press Enter. The message appears in read note form  
 
 (Deleting message) 
To manage the number of messages you keep in your Inbox, you should delete messages you’ve 
already read and no longer need. 
 
To delete a message from the Inbox 
1. In the Inbox, select the second Test Message. To  select Test Message, click it, or press 

TAB to move the highlight to the message list, use the ARROW KEYS to highlight it, and 
then press ENTER. 

2. Click the Delete button, or from the File menu, choose Delete (ALT, F,D). 
 
The message moves to the Wastebasket, where you can retrieve it until it is deleted there. The 
default Mail setting deletes messages in the Wastebasket when you quit Mail. To change this 
option, choose Options from the Mail menu. 

  
 
 



 
Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Able to read and delete 
messages 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1.1 Reading message 
 
1.2 Deleting message 
 
 
 

 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 



Product Assessment 
 

Product Specifications Assessment 
 Acceptable Needs for the 

Adjustments 
Not Acceptable 

(1) Message  read 
(2) Message is deleted 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
 
 



 
KNOWLEDGE ASSESSMENT 
ORAL WRITTEN 
(1) Explain how to read and delete 

messages? 
 
 
  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



TRADE:  COMPUTER APPLICATIONS 

 
 
 
 
LEVEL  1 
 
 
 
 
 
 
 
 
Module: 05 ELECTRONIC MAIL 
 
 
Unit:   5.1 SEND AND RECEIVE E-MAIL 

[TLE]:            5.1.7 REPLYING AND FORWARDING EMAIL MESSAGES 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Vocational Education and Training Authority (VETA) 



 
1. Preparation of Training 
 
 
 
 
Learning objective 

 
At the end of this element, the trainee must be able to reply and 
forward e-mail 
 

 
Duration 

 
30 minutes 
 

 
Equipment/tools 

 
Computer connected to the internet 
 

 
Training Materials 

 
NIL 
 

 
Teaching AIDS 

 
Information sheet 
 

 
 
Reference Materials 

 
 
E-mail reference books 
 
 

 
 
Trainees 
preparation 
 
 

 
  
Be aware of the computer room regulations 
 
 

 
 
 
 
 
 
 
 
 



 
2.   Presentation of training/teaching steps 
 

Demonstrate and explain the steps to send E-mail messages 
 
Steps: 
 
(Replying a message)  
(1) To create a reply to addressed to the original sender select Reply from the 

message menu 
(2) To create a reply addressed to the original sender and all of the original recipients 

select reply to all from the message menu 
 
 (Forwarding a message) 
(1) To forward a current message, select forward from the message menu. A new 

message window is displayed with your address in the From field, and the 
original sender’s text quoted in the message body. Make any changes you want, 
and enter the recipient’s address in the To field. 

(2) The message can be sent or saved for further changes. The message that have 
been forwarded are identified with an “F” in the status column of their message 
summary. 

 
 
 
 



 
3. Information sheet (hand out) 
 
 
Replying a message 
(1) To create a reply addressed to the original sender and select Reply form the message 

menu. 
 
(2) To create the reply addressed to the original sender, and all of the original recipient, 

select reply to all from the message menu. 
 
Forwarding a message  
(1) To forward a current message, select forward from the message menu. A new message 

window is displayed with your address in the From field, and the original sender’s text 
quoted in the message body. Make any changes you want and enter the recipient’s 
address in the to field. 

 
(2) The message can be sent or saved for further changes. The message that have been 

forwarded are identified with on “F” in the status column of their messages summary. 
 

 
 
 
 
 
 
 
 



 
Practical performance Assessment 
Direct Performance 
 

Performance Criteria Direct Performance Assessment 
 I II III 
    

 Able to reply and forward 
message 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1.1 Message is replied 
 
1.2 Message is Forwarded 
 
 
 

 

 
KEY: I - Has started but need further experience 
 II - Competent but with supervision 
 III - Competent unaided 
 
 



Product Assessment 
Product Specifications Assessment 

 Acceptable Needs for the 
Adjustments 

Not Acceptable 

(1) Message  replied  
(2) Message forwarded 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   

 
 
 



KNOWLEDGE ASSESSMENT 
ORAL WRITTEN 
What is an email? 
 
  
 
 

 
Write down the advantages of using email 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 


